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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 

the user’s authority to operate this equipment. 

Class B Declaration of Conformity

This equipment has been tested and found to comply with the limits for a class B digital device, pursuant to Part 15 of the FCC rules. These limits are designed 

to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy 

and if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. 

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 

encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with non-approved equipment or unshielded 

cables is likely to result in interference to radio and TV reception. The user is cautioned that changes and modifications made to the equipment without the 

approval of manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice

This Class B digital apparatus meets all the requirements of the Canadian Interference-Causing Equipment Regulations.

Avis de Conformation Classe B de l’Industrie Canada 

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Certificate by Manufacturer/Importer

This is to certify that the FC07 is shielded against radio interference in accordance with the provisions of VFG 243/1991. The German Postal Services have been 

advised that this device is being put on the market and that they have been given the right to inspect the series for compliance with the regulations.
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Bescheinigung des Herstellers/Importeurs

Heirmit wird bescheinigt, dass der FC07 im Uebereinstimmung mit den Bestimmungen der VFG 243/1991 Funk-Entstort ist. Der Deutschen Bundespost wurde 

das Inverkehrbringen dieses Geraetes angezeigt und die Berechtigung zur Ueberpruefung der Serie auf Einhaltung der Bestimmungen eingeraumt.

Electronics for Imaging, Inc.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 

operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 

who is responsible for compliance of his particular installation.

Dieses Geraet wurde einzeln sowohl als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funk-entstoerbestimmungen 

geprueft. Es ist jedoch moeglich, dass die Funk-enstoerbestimmungen unter unguenstigen Umstaenden bei anderen Geraetekombinationen nicht eingehalten 

werden. Fuer die Einhaltung der Funk-entstoerbestimmungen seigner gesamten Anlage, in der dieses Geraet betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Einhaltung mit betreffenden Bestimmungen kommt darauf an, dass geschirmte Ausfuhrungen gebraucht werden. Fuer die beschaffung richtiger Ausfuhrungen 

ist der Betreiber verantwortlich.



Software License Agreement

Before using the Software, please carefully read the following terms and conditions. BY USING THIS SOFTWARE, YOU SIGNIFY THAT YOU HAVE 

ACCEPTED THE TERMS OF THIS AGREEMENT.  If you cannot or do not accept these terms, you may return the entire package within ten (10) days to 

the Distributor or Dealer from which you obtained them for a full refund.

Electronics for Imaging, Inc. grants to you a non-exclusive, non-transferable license to use the software and accompanying documentation (“Software”) included 

with the Fiery XJ you have purchased, including without limitation the PostScript®  software provided by Adobe Systems Incorporated.

You may:

a. use the Software solely for your own customary business purposes and solely with Fiery XJ;

b. use the digitally-encoded machine-readable outline and bitmap programs (“Font Programs”) provided with Fiery XJ in a special encrypted format (“Coded Font 

Programs”) to reproduce and display designs, styles, weights, and versions of letters, numerals, characters and symbols (“Typefaces”) solely for your own customary 

business purposes on the display window of the Fiery XJ or monitor used with Fiery XJ;

c. use the trademarks used by Electronics for Imaging to identify the Coded Font Programs and Typefaces reproduced therefrom (“Trademarks”); and

d. assign your rights under this Agreement to a transferee of all of your right, title and interest in and to Fiery XJ provided the transferee agrees to be bound by all 

of the terms and conditions of this Agreement.

You may not:

a. make use of the Software, directly or indirectly, to print bitmap images with print resolutions of 600 dots per inch or greater, or to generate fonts or typefaces 

for use other than with Fiery XJ;

b. make or have made, or permit to be made, any copies of the Software, Coded Font Programs, accompanying documentation or portions thereof, except as 

necessary for use with the Fiery XJ unit purchased by you; provided, however, that under no circumstances may you make or have made, or permit to be made, 

any copies of that certain portion of the Software which has been included on the Fiery XJ hard disk drive. You may not copy the documentation; 

c. attempt to alter, disassemble, decrypt or reverse engineer the Software, Coded Font Programs or accompanying documentation.

d. rent or lease the Software.

Proprietary Rights

You acknowledge that the Software, Coded Font Programs, Typefaces, Trademarks and accompanying documentation are proprietary to Electronics for Imaging 

and its suppliers and that title and other intellectual property rights therein remain with Electronics for Imaging and its suppliers. Except as stated above, this 

Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any other rights, franchises or 

licenses in respect of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation. You may not adapt or use any trademark or 

trade name which is likely to be similar to or confusing with that of Electronics for Imaging or any of its suppliers or take any other action which impairs or reduces 

the trademark rights of Electronics for Imaging or its suppliers. The trademarks may only be used to identify printed output produced by the Coded Font Programs. 

At the reasonable request of Electronics for Imaging, you must supply samples of any Typeface identified with a trademark.

Confidentiality

You agree to hold the Software and Coded Font Programs in confidence, disclosing the Software and Coded Font Programs only to authorized users having a need 

to use the Software and Coded Font Programs as permitted by this Agreement and to take all reasonable precautions to prevent disclosure to other parties.

Remedies

Unauthorized use, copying or disclosure of the Software, Coded Font Programs, Typefaces, Trademarks or accompanying documentation will result in automatic 

termination of this license and will make available to Electronics for Imaging other legal remedies.

Limited Warranty And Disclaimer

Electronics for Imaging warrants that, for a period of ninety (90) days from the date of delivery to you, the Software under normal use will perform without 

significant errors that make it unusable. Electronics for Imaging’s entire liability and your exclusive remedy under this warranty (which is subject to you returning 

Fiery XJ to Electronics for Imaging or an authorized dealer) will be, at Electronics for Imaging’s option, to use reasonable commercial efforts to attempt to correct 

or work around errors, to replace the Software with functionally equivalent software, or to refund the purchase price and terminate this Agreement. Some states 

do not allow limitations on duration of implied warranty, so the above limitation may not apply to you.

Except for the above express limited warranty, Electronics for Imaging makes and you receive no warranties or conditions on the Products, express, implied, or 

statutory, and Electronics for Imaging specifically disclaims any implied warranty or condition of merchantability or fitness for a particular purpose.

For warranty service, please contact your authorized service/support center.



EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, ELECTRONICS FOR IMAGING MAKES AND YOU RECEIVE NO WARRANTIES 

OR CONDITIONS ON THE SOFTWARE OR CODED FONT PROGRAMS, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION 

OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND ELECTRONICS FOR IMAGING SPECIFICALLY DISCLAIMS ANY IMPLIED 

WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Electronics for Imaging does not warrant that 

the operation of the software will be uninterrupted or error free or that the Software will meet your specific requirements.

Limitation Of Liability

IN NO EVENT WILL ELECTRONICS FOR IMAGING OR ITS SUPPLIERS BE LIABLE FOR ANY DAMAGES, INCLUDING LOSS OF DATA, LOST 

PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE USE OF 

THE SOFTWARE, CODED FONT PROGRAMS OR ACCOMPANYING DOCUMENTATION, HOWEVER CAUSED AND ON ANY THEORY OF 

LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ELECTRONICS FOR IMAGING OR ANY AUTHORIZED DEALER HAS BEEN ADVISED 

OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE UNIT REFLECTS THIS ALLOCATION OF RISK. 

BECAUSE SOME STATES/JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR 

INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software or Coded Font Programs in any form without the appropriate United States and foreign government 

licenses. Your failure to comply with this provision is a material breach of this Agreement.

Government Use

Use, duplication or disclosure of the Software by the United States Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 

Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) (1) and (2) of the Commercial Computer Software—Restricted 

Right Clause at 48 CFR 52.227-19, as applicable.

Third Party Beneficiary

You are hereby notified that Adobe Systems Incorporated, a California corporation located at 345 Park Avenue, San Jose, CA  95110-2704 (“Adobe”) is a third-

party beneficiary to this Agreement to the extent that this Agreement contains provisions which relate to your use of the Fonts, the Coded Font Programs, the 

Typefaces and the Trademarks licensed hereby.  Such provisions are made expressly for the benefit of Adobe and are enforceable by Adobe in addition to Electronics 

for Imaging.

General

This Agreement will be governed by the laws of the State of California.

This Agreement is the entire agreement held between us and supersedes any other communications or advertising with respect to the Software, Coded Font 

Programs and accompanying documentation.

If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions concerning this Agreement, please write to Electronics for Imaging, Inc., Attn: Licensing Dept. or see Electronics for Imaging’s web site 

at www.efi.com.

Electronics for Imaging, Inc.

2855 Campus Drive

San Mateo, CA 94403
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xi Copier support  and media pack

The Fiery XJ BP100 enables you to use your color copier as a networked printer. You 

can use the Fiery XJ BP100 to print final documents or to proof jobs you will later 

print on an offset press. You send a print job to the Fiery XJ BP100 as you would to 

any other printer—you select it from the Printers dialog box on Windows computers, 

or in the Chooser on Mac OS computers—and then print from within any 

application.

NOTE: In this manual, the term “Fiery XJ” is used to refer to the Fiery XJ BP100.

Users with the necessary access privileges can monitor and manage jobs sent to the 

Fiery XJ and perform color calibration of the color server using AutoCal. Additionally, 

with Fiery XJ user software, you can also download files and fonts to the Fiery XJ.

Copier support  and media pack

The Fiery XJ supports R2 color copiers—the term “copier” refers to the following 

models:

• Ricoh Aficio Color 5106 and 5206

• Lanier 5606DC

• Sharp AR-C861 and AR-C862

• Gestetner 2606 and 2606e

• nashuatec C606 and C606e

• Rex Rotary CC8606 and CC8606E

• infotec 7316 and 7316E

• Savin SDC206 and SDC206E

Your Fiery XJ includes a media pack containing:

• User Software CD

• Documentation set

Preface



xii Preface

About the documentat ion

This manual is part of a set of Fiery XJ documentation that includes the following 

manuals for users and system administrators:

• The Administrator Guide explains basic configuration and administration of the 

Fiery XJ for the supported platforms and network environments. It also includes 

guidelines for setting up UNIX, Windows NT, and Novell NetWare servers to 

provide Adobe PostScript printing services to clients.

• Getting Started describes how to install software to enable users to print to the 

Fiery XJ. Specifically, it describes installation of PostScript™  printer drivers, printer 

description files, and other user software provided on the Fiery XJ User Software 

CD. It also explains how to connect each user to the network.

• The User Guide describes the printing features of the Fiery XJ for users who send 

jobs via remote workstations on the network or via a direct parallel port connection. 

It also explains the functions of the Fiery WebTools and Fiery XJ client utilities and 

how they can be used to manage jobs, and provides troubleshooting information for 

problems that may arise.

• Release Notes provide last-minute product information and workarounds for some of 

the problems you may encounter.

About this manual

This manual covers the following topics:

• Using the Fiery XJ Control Panel

• Printing from Windows computers

• Printing from Mac OS computers

• Printing from UNIX® workstations

• Downloading files and fonts using Fiery Downloader

• Tracking and managing jobs and accessing information using Fiery WebTools™  and 

Fiery client utilities

• Calibrating the Fiery XJ with AutoCal™

• Specifying and overriding job settings, the printer fonts installed on the Fiery XJ, 

and troubleshooting information



xii i How the Fiery XJ works

Terminology and conventions

Specific terms are explained as they are introduced. However, the following general 

terms are used throughout:

• PostScript  ( PS) —A computer language designed as a page description language. The 

Fiery XJ uses this language for imaging the page and for communication with 

applications and with the print engine.

• Job—A file consisting of PostScript commands and comments that describe the 

graphics, sampled images, and text that should appear on each page of a document, 

and the printer options that should be used in printing, such as media or color 

rendering style.

• Spool—Write to a disk. Usually used here to refer to a PostScript print job being 

saved to the Fiery XJ hard disk in preparation for processing and printing.

• RI P—Acronym for raster image processing, which changes text and graphics 

commands into descriptions of each mark on a page. In common use as a noun, a 

“raster image processor” (RIP) is the computer processor that performs this function.

• Print—The process of rendering, or imaging, a page or a job on a printer.

These concepts can explain how the Fiery XJ and the copier work together as a 

powerful printing system. The Fiery XJ PostScript RIP changes text and graphics 

commands in PostScript into color specifications for each dot of toner deposited on 

a page by the copier.

How the Fiery XJ works

The Fiery XJ receives files from computers on the network, processes (RIPs) those files, 

and then sends them to the copier’s print engine for printing. Even with the Fiery XJ 

installed, you can still use the copier to make copies. 

When printing from an application, your Windows or Mac OS computer 

communicates with the Fiery XJ by means of a PostScript printer driver and a 

PostScript printer description file (PPD). 



xiv Preface

About PostScript  printer drivers and PPDs

A PostScript printer driver is an application that manages printing communication 

between your application software and the printer. It interprets the instructions 

generated by the application software, merges those instructions with printer-specific 

PPD options you specify (see below), and translates all that information into 

PostScript, a language the printer understands. In other words, the printer driver writes 

a PostScript file based on your original file and the options you set from the Print 

dialog box.

A PPD file contains information about a particular device’s features and capabilities 

(for example, what paper sizes and media types are supported). The PostScript printer 

driver reads the information in the PPD file and presents that information to you in 

the form of options you can choose from the Print dialog box. The PPD for the 

Fiery XJ includes information about the features of both the copier and the Fiery XJ.

For information on the PPD options for your Fiery XJ, see Appendix A, “Print 

Options.”

Supported paper sizes

The Fiery XJ supports printing at 400 dpi (dots per inch) on the following paper sizes:

• 8" x 10"-R

• Letter, Letter-R (8.5" x 11")

• Legal 13 (8.5" x 13")

• Legal (8.5" x 14")

• Tabloid (11" x 17")

• A6-R (105 mm x 148 mm)

• A5, A5-R (148 mm x 210 mm)

• A4, A4-R (210 mm x 297 mm)

• A3 (297 mm x 420 mm)



xv Fiery XJ job environments

Fiery XJ job environments

The Fiery XJ supports several levels of control of printing, job management, and setup, 

and offers you the flexibility to choose the configuration that corresponds to the 

requirements of your site. If desired, the administrator can implement controls that 

limit user access to certain Fiery XJ functions, including Fiery XJ configuration 

(Setup), calibration, job overrides, and font management.

The spectrum of control that an administrator can implement is described fully in the 

Administrator Guide.

Permissions

Support for various types of job environments is achieved by a combination of Fiery XJ 

Setup options. By default, anyone can access Setup, but the administrator can limit 

access to Setup by specifying an Administrator password for the Fiery XJ (see the 

Administrator Guide).

The two security levels are:

• Administrator—confers control of Setup and is the highest level of control. The 

person who has access to Setup can control the printing and job management 

environment by choosing which print connections are enabled, and by electing to 

set passwords.

• Guest—allows users to view the status of active jobs and the list of stored jobs. They 

cannot make changes to jobs. A password is not needed to log in as Guest and view 

jobs from the Fiery WebSpooler or Fiery Spooler windows.

This manual describes the features of the Fiery WebTools and Fiery client utilities, as 

well as all privileges, whether those privileges are available to everyone or are exclusive 

to only certain people. It also includes descriptions of administrator functions, 

sometimes referring you to other manuals for more information.
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Before you begin

Before using the Fiery XJ, follow these steps:

1. Confirm that  the system administrator has completed Setup as described in the 

Administ rator Guide.

2 . Determine which printer defaults the administrator has specified in Setup. 

These default settings can affect the results of your print jobs. Check with your 

administrator or operator for information on these default settings.

3. Confirm that  the user software is installed correct ly on your workstat ion, as described 

in Get t ing Start ed.

4 . Find out how your workstat ion is configured for print ing on the network.

If you send a job to the Print queue, the job spools to the Fiery XJ and proceeds to RIP 

and print according to your job settings—unless someone intervenes with 

Fiery WebSpooler or Fiery Spooler.

You may also have access to the Direct connection, which sends jobs straight to the 

server without spooling and is used to download printer fonts to the Fiery XJ disk.

5. Determine whether the Fiery XJ is set  up to use Fiery WebTools and what your access 

privi leges are.

The administrator may or may not have enabled access to the server via the Internet 

(or an intranet). If access is enabled, a password may be required to perform job 

management with Fiery WebSpooler or Fiery Spooler. 



1
1-1 I ntroduction to the Fiery XJ Control Panel

You can use the Fiery XJ Control Panel to view status information, print special pages, 

and set up printing. 

I ntroduction to the Fiery XJ Control Panel

The Control Panel, shown below on the front of the Fiery XJ, comprises the following 

parts:

Activity light

The activity light indicates the current Fiery XJ activity. If the light is:

Solid red An error has occurred causing the Fiery XJ to be disabled.

Flashing red There is an error causing printing to be disabled, but the 

Fiery XJ is capable of processing.

Solid green The Fiery XJ is idle.

Flashing green The Fiery XJ is processing or printing a job, or 

communicating with a remote computer.

No light The Fiery XJ is off or starting up.

Chapter 1:

Using the 

Control Panel

Line select ion buttons

Display window

Activity light

Up and down buttons

Menu button
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1-2 Using the Control Panel

Buttons

Display window

The display window provides information about the status of the Fiery XJ, displays 

menu information, and enables you to view and edit information in the Setup menus. 

The last line of the display window displays text that tells you what screen you are 

looking at and highlights one of the icons to indicate what the Fiery XJ is doing. Only 

the icons for the screens that are currently available appear. The menu button cycles 

among the active screens.

The screens are:

Line selection 

buttons

There are four line selection buttons on the right side of the 

Control Panel. Use these buttons to select the command 

displayed on the corresponding line of the display window. 

When a button is active, a special character (>) appears in the 

display window next to the button.

Up and down 

buttons

Use these buttons to scroll to different screens in multi-

screen lists, to select Setup options from a list of available 

options, and to scroll alphanumeric characters. 

Menu button Press this button to view other screens. Under normal 

operation, the Control Panel displays the Info, RIP, or Print 

Status screen with information about the status of the 

Fiery XJ. If you press the Menu button, the Functions menu 

is displayed and you can perform additional operations (see 

page 1-4). If a job is processing or printing, press the Menu 

button to cycle among the active screens.

Alert Status If there is a problem with processing a job or printing functions, an error message 

appears on the Control Panel. For information on error messages, see 

Appendix C, “Troubleshooting.” 
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Print Status When the Fiery XJ is printing a job, the Print Status screen appears. This screen 

displays the following:

Cancel Jo b—Press the top line selection button to cancel the job currently 

printing. 

User name—The name of the user who sent the job currently processing.

Pages/ To tal—The number of copies of the current job printed and the total 

number of copies of the job requested.

RIP Status When the Fiery XJ is processing a job, the RIP Status screen appears. This screen 

displays the following:

Cancel Jo b—Press the top line selection button to cancel the job currently 

processing. The Fiery XJ cancels the job before printing begins.

Do cument name—The name of the document currently processing.

User name—The name of the user who sent the job currently processing.

Kilo bytes—The size (in kilobytes) of the job processed so far. NOTE: This number 

is always displayed in kilobytes, even if the amount goes over 1000KB; for 

example, 10MB is displayed as 10000KB.

Info Status When the Fiery XJ is not processing or printing a job, it displays information 

about the current server and software. It displays the following information:

Server Name—The Fiery XJ name.

Status—The current status of the Fiery XJ. The Fiery XJ status can be: Idle, 

Initializing, Busy, Processing, or Printing.

Megabytes—The space (in megabytes) available on the Fiery XJ hard disk, for 

example, 756MB.

Versio n—The system software version running on the Fiery XJ.

Functions You can press the Menu button to display the Functions menu. Use the up and 

down buttons to scroll through the list. Press the line selection button to the right 

of a command to select that command. See page 1-4 for more information.

Network The network icon appears at the bottom left of any of the other screens when a 

job is being sent to the Fiery XJ, either over the network or through the parallel 

port. The network icon also appears, together with a flashing green activity light, 

when a remote utility is running.
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Functions menu

The Functions menu provides the following commands:

Print Pages Print special pages from the Fiery XJ. You can print the following pages from the 

submenu that appears:

Test Page—A Test Page enables you to confirm that the Fiery XJ is properly 

connected to the copier, and provides color and grayscale samples to troubleshoot 

problems with the copier or the Fiery XJ. The following settings are among those 

listed on the Test Page: Server Name, Printer Model, color settings, calibration 

information, date and time the Test Page was printed.

Co nfiguratio n—Prints the Configuration page, which gives the current server and 

device configuration. This page lists general information about the hardware and 

software configuration of the Fiery XJ, the current options for all Setup settings, 

information about the current calibration, and the Ethernet and Token Ring 

addresses of the Fiery XJ. 

Jo b Lo g—Prints a log of the last 55 jobs. For information on the fields in the Job 

Log and on printing it in other forms, see Chapter 6, "Tracking and Managing 

Print Jobs."

Co ntro l Panel Map— Prints the Control Panel Map, which is an overview of the 

screens you can access from the Control Panel. For information about using these 

screens to set up the Fiery XJ, see the Administrator Guide.

Fo nt List—Prints a list of all fonts currently on the Fiery XJ hard disk.

Suspend Printing Suspend communication between the Fiery XJ and the copier. You must suspend 

printing if you want to interrupt the current Fiery XJ job so that you can use the 

copier to make copies. Jobs continue to process on the Fiery XJ. After you make 

the copies, select Resume Printing  to continue printing jobs from the Fiery XJ and 

networked users.

NOTE: Do not select Suspend Printing while printing sort jobs.

Resume Printing Resume communication between the copier and the Fiery XJ after you have 

finished making copies. 

Run Diagno stics This function is provided for service representatives only. Contact your authorized 

service/support technician for information about running diagnostics.

Rebo o t Server Shut down all Fiery XJ activity in the correct manner and then restart. You should 

use this option instead of the power switch on the back of the Fiery XJ.
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Start ing and shutt ing down the Fiery XJ

Generally, you can leave the Fiery XJ running all the time. This section describes how 

to shut down and restart the Fiery XJ when necessary.

Start ing the Fiery XJ

To start the Fiery XJ, move the power switch on the back of the Fiery XJ to the On 

position. If the copier is also powered off, power it on before powering on the Fiery XJ.

Diagnostic messages appear on the Fiery XJ Control Panel. If any diagnostics fail, more 

information and instructions appear. Contact your service representative if the 

Fiery XJ encounters problems while running the diagnostics.

When the diagnostics are finished, the following message is displayed:

Fo r so ftware update o r setup,  press any key.

If you want to change Setup option settings, press any button; if you do not press a 

button, the Fiery XJ continues starting up and displays the message Idle  when it is 

ready to receive data.

NOTE: If an Administrator password has been set, you are required to enter it to access 

Setup.

Power switch in the 

off  posit ion
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If you press a button, the following options appear. For information about the Setup 

menus and options, see the Administrator Guide.

Restart ing the Fiery XJ

You should use the procedure described below to restart the Fiery XJ rather than using 

the power switch on the back of the Fiery XJ.

TO RESTART THE FI ERY XJ:

1. Make sure that  the Fiery XJ is not  receiving, processing, or print ing a job. 

Make sure that the status message on the Control Panel is Idle .

NOTE: If a job from the Print queue is processing, it will continue processing and print 

after the Fiery XJ is restarted; if a job sent to the Direct connection is processing, it will 

not finish processing or printing.

2. Press the Menu button to display the Functions menu.

3. Use the up and down buttons to scroll to the last  screen and choose Reboot Server.

Choose: To do this:

Exit Setup Exit the Setup menus; the Fiery XJ reboots.

Server Setup Enter the Server Setup menus. 

Netwo rk Setup Enter the Network Setup menus.

Printer Setup Enter the Printer Setup menus.

PS Setup Enter the PostScript Setup menu.

Co lo r Setup Enter the Color Setup menu.

Jo b Lo g Setup Enter the Job Log Setup menu.

Calibratio n Calibrate the Fiery XJ using AutoCal. For more 

information, see “Calibrating with AutoCal from the 

Control Panel” on page 7-5 and the Administrator Guide.

Change Passwo rd Change the Administrator password.

Clear Server Clear all jobs in all server queues as well as the Job Log. 

Check with your administrator or operator before 

choosing Clear Server.
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Shutt ing down the Fiery XJ

You may need to shut down the Fiery XJ for service. When you do so, fonts that have 

been downloaded to the hard disk drive are not deleted. Print jobs in the Printed queue 

and jobs that have been processed but not printed are not deleted and are available for 

printing when you restart the Fiery XJ.

TO SHUT DOWN  THE FI ERY XJ:

1. Make sure that  the Fiery XJ is not  receiving, processing, or print ing a job.

Make sure that the status message on the Control Panel is Idle . If a job has just finished 

processing or printing, wait at least five seconds after the Control Panel status message 

switches to Idle  before proceeding to step 2.

NOTE: If a job from the Print queue is processing, it will continue processing and print 

after the Fiery XJ is restarted; if a job to the Direct connection is processing, it will not 

finish processing or printing.

2. Power off  the Fiery XJ by moving the power switch on the back to the Off  posit ion.

NOTE: After powering off the Fiery XJ, make sure to also power off the copier. Leaving 

the copier powered on while the Fiery XJ is powered off can lead to excessive drain on 

the Fiery XJ motherboard battery.

Safety warnings

The Fiery XJ display window is a liquid crystal display (LCD) that is made of glass and 

can break. Do not subject it to strong shocks.

If the display window breaks and the liquid crystal material leaks out, do not inhale, 

ingest, or touch it. If the material gets on your skin or clothing, wash it off with soap 

and water immediately.

Cleaning the Fiery XJ

Clean the Fiery XJ with a soft cloth moistened with isopropyl alcohol or ethyl alcohol. 

Never use water or ketone as these may permanently alter the display.
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This chapter describes how to print to the Fiery XJ from Windows 95 and 

Windows NT 4.0.

You can print from a networked Windows computer, or from a Windows computer 

connected to the parallel port on the Fiery XJ. If you plan to print files at another 

location, you should follow the procedures described in “Saving files to print at a 

remote location” on page 2-8.

Another way to print from a Windows computer is to download PostScript or 

Encapsulated PostScript (EPS) files using Fiery Downloader.

NOTE: For information on setting up the Windows environment for printing with 

Windows servers connected to the Fiery XJ, see the Administrator Guide. For 

information on how to connect to the Fiery XJ over the network, install printer 

drivers, and install the Fiery utilities, see Getting Started.

Print ing from applicat ions

Once you have installed the Fiery XJ printer driver and set it to the proper port as 

described in Getting Started, you can print directly from most Windows applications. 

Simply choose the Print command from within your application.

Sett ing options and print ing from Windows 95

To print from Windows 95, use the Adobe PostScript printer driver for Windows 95. 

The driver is included with the Fiery XJ user software, and uses all features of the 

Fiery XJ.

Once you have installed the Adobe PostScript printer driver and Fiery XJ PostScript 

Printer Description file (PPD), you can specify print settings. You can also change 

settings for a particular job when you print it to the Fiery XJ. Before printing, make 

sure that the correct print options are set.

Chapter 2:

Print ing 

from Windows 

Computers 
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To print from Windows 95 applications over a network, you must be connected to a 

print server. This can be a Novell NetWare server, an NT server, or a UNIX server. For 

information about connecting a server to the Fiery XJ, see the Administrator Guide. 

Alternatively, you can print from Windows 95 without connecting to a print server via 

SMB printing. For information about setting up SMB printing, see Getting Started.

TO SET PRI NT OPTI ONS AND PRI NT WI TH  THE ADOBEPS PRI NTER DRI VER 

FROM WI NDOWS 9 5 :

1. Double-click the My Computer icon.

2. Double-click the Printers icon.

3. Select  the icon for the Fiery XJ and choose Propert ies from the File menu.

4. Click the Paper tab.

5. Specify the appropriate sett ings for the print  job.

In the Paper size area, specify the page size for the job.
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From the Paper source pop-up menu, choose the paper tray for the job. For example, 

you can specify that the job should be printed on pages in the Bypass tray. The Paper 

source selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 

type than that of the job you are sending, the Fiery XJ displays an error message and 

the job will not print. You should then load the correct paper in the selected tray or 

cancel the job.

6. To select  a specific media type, click More Options.

7. From the Paper type pop-up menu, choose the type of  media to use for the job and 

click OK.
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8. Click the Fiery Options tab.

9. Go to the Job, Color, and Finishing tabs, and specify the appropriate sett ings for the 

print  job.

These print options are specific to the Fiery XJ. They override settings in Fiery XJ 

Printer Setup; the settings can also be changed in the Override Print Settings dialog 

box with the Fiery WebSpooler or Fiery Spooler. For information about these options 

and overrides, see Appendix A, “Print Options.”

If you choose Printer’s default , the Fiery XJ prints with the default setting specified 

during Setup.

10. I f  you want to make the new sett ings the default  sett ings, click Apply.

11. Click OK.
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12. From your applicat ion, choose Print .

13. Enter text  messages in the Notes 1 and Notes 2 areas. 

Enter user and job identification information for accounting purposes, or whatever 

information is required at your site. These notes will appear in the Job Log.

14. Click OK.

NOTE: The Fiery XJ does not support printing the Cover Page from the AdobePS 

printer driver.

Saving and loading print  opt ion sett ings

Print option settings can be saved to a settings file on your hard disk. Saving a settings 

file enables you to easily load specifically configured settings for a particular job. 

TO SAVE PRI NT OPTI ON  SETTI NGS:

1. After configuring the options from the Job, Color, and Finishing tabs, click 

Save Sett ings.

2. Name the sett ings file and browse to a locat ion on your hard disk where you want to 

save the fi le.

3. Click OK.

The settings file is saved to the location you specified.
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TO LOAD PRI NT OPTI ON  SETTI NGS:

1. From the Fiery Options tab, click Load Sett ings.

2. Browse to the sett ings file.

3. Select  the sett ings file from the list  and click OK.

The options from the Job, Color, and Finishing tabs are automatically configured with 

the saved settings.

Sett ing options and print ing from Windows NT 4.0

You can print from Windows NT 4.0 using the printer driver included with 

Windows NT.

TO SET PRI NT OPTI ONS AND PRI NT WI TH  THE MI CROSOFT POSTSCRI PT 

PRI NTER DRI VER FROM WI NDOWS NT 4 .0 :

1. Choose Print  in your applicat ion and click Propert ies.

2. Click the Advanced tab.

3. Specify the appropriate sett ings for the print  job.
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In the Paper Size menu, specify the page size for the job.

From the Paper Source menu, choose the paper tray for the job. For example, you can 

specify that the job should be printed on pages in the Bypass tray. The Paper Source 

selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 

type than that of the job you are sending, the Fiery XJ displays an error message and 

the job will not print. You should then load the correct paper in the selected tray or 

cancel the job.

4. Scroll down to Printer Features, and select  the appropriate sett ings for the print  job.

These print options are specific to the Fiery XJ. They override settings in Fiery XJ 

Printer Setup; the settings can also be changed in the Override Print Settings dialog 

box with the Fiery WebSpooler or Fiery Spooler. For information about these options 

and overrides, see Appendix A, “Print Options.”

If you choose Printer’s default , the Fiery XJ prints with the default setting specified 

during Setup.
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5. Click OK, then click OK in the Print  dialog box.

NOTE: The Fiery XJ does not support printing the Cover Page from the Microsoft 

PostScript printer driver for Windows NT 4.0.

Print ing to the parallel port

The Fiery XJ has a parallel port that enables you to print most files directly from a 

Windows computer if your network administrator has connected the Windows 

computer’s parallel port to the Fiery XJ parallel port.

NOTE: You cannot use Fiery Downloader through the parallel port.

TO PRI NT FI LES TO THE PARALLEL PORT:

1. Make sure the parallel port  is enabled on the Fiery XJ.

Check with your site administrator to see whether printing to the parallel port is 

enabled. See Getting Started for information on setting up parallel port printing on 

your Windows computer.

2. Select  the printer port  that  is connected to the Fiery XJ parallel port .

Select one of the local ports: LPT1 , LPT2 , or LPT3 . For instructions, see your Windows 

documentation. 

3. Print  from within your applicat ion.

Saving files to print  at  a remote locat ion

If you do not have a Fiery XJ and are preparing files to take to a service bureau or other 

location, print the final files to the File port (as opposed to one of the local ports). You 

can also print to the File port to create a file to be downloaded using 

Fiery Downloader. For instructions, see your Windows documentation.
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Using Fiery Downloader to print

Downloading files with Fiery Downloader is generally faster than printing from 

application software. You can use Fiery Downloader to print PostScript or EPS files.

TO PRI NT USI NG FI ERY DOWNLOADER:

1. Create a PostScript  or EPS file. Specify the appropriate print  opt ions and include 

( embed)  any necessary fonts that  are not resident on the Fiery XJ.

For a list of fonts resident on the Fiery XJ, see Appendix B, “Font List.”

2. Launch Fiery Downloader and connect to the Fiery XJ.

For instructions on setting up Fiery Downloader, see Getting Started.

3. Select  the fi le( s)  you want to download, and specify any necessary options.

4. Click Download.

For details, see Chapter 5, “Downloading Files and Fonts.”
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You can print to the Fiery XJ just as you would print to any other printer from any 

application software. First, select the Fiery XJ as the current printer in the Chooser, 

and then print the file from within your application.

Another way to print from a Mac OS computer is to download PostScript or 

Encapsulated PostScript (EPS) files using Fiery Downloader.

Print ing from applicat ions

Before you can print to the Fiery XJ from applications, you must select the Fiery XJ in 

the Chooser. Then, using the Adobe PostScript printer driver and the correct 

PostScript Printer Description file (PPD), you can control many Fiery XJ printing 

features by specifying job settings from print dialog boxes. 

Select ing the Fiery XJ in the Chooser

Before you print a job, make sure the Fiery XJ is the currently selected printer.

TO SELECT THE FI ERY XJ AS THE CURRENT PRI NTER:

1. Make sure the Fiery XJ is connected to the network and turned on.

2. Choose Chooser from the Apple menu.

3. Click the AdobePS icon to select  i t .

4 . I f  the network is divided into zones, select  the zone in which the Fiery XJ is located.

5. Select  the Fiery XJ by <Server Name>_<Device Name>_<Queue Name> from the 

“Select  a PostScript  Printer” list .

The names of all supported printers in the zone appear in the scroll list on the right. 

For information about setting up the Fiery XJ in the Chooser, see Getting Started.

NOTE: If your system administrator has not enabled the connection to the Print queue 

or the Direct connection, the corresponding name will not appear in this list.
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6. Make sure that  AppleTalk is set  to Act ive, and then close the Chooser window.

The Fiery XJ remains selected as the current printer until you choose a new printer in 

the Chooser.

Sett ing print  opt ions and print ing from Mac OS computers

In Mac OS applications, print options are set from both the Page Setup dialog box and 

the Print dialog box. For details, see Appendix A, “Print Options.” 

NOTE: Some default print options are set by the administrator during Setup. Check 

with the administrator for information on the current server default settings.

TO SET PRI NT OPTI ONS AND PRI NT WI TH  THE ADOBEPS 

PRI NTER DRI VER:

1. Open the file you want to print , and choose Page Setup from the applicat ion’s File 

menu.

The AdobePS Page Setup dialog box appears.

2. I n the Paper pop-up menu, specify the page size for the job and click OK.

3. Choose Print  from the applicat ion’s File menu.

NOTE: Print dialog boxes vary across applications.

If the Print dialog box lets you select from a pop-up menu of available printers, choose 

the Fiery XJ.
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From the Paper Source pop-up menu, choose the paper tray for the job. For example, 

you can specify that the job should be printed on pages in the Bypass tray. The Paper 

Source selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, and/or media 

type than that of the job you are sending, the Fiery XJ displays an error message and 

the job will not print. You should then load the correct paper in the selected tray or 

cancel the job.

4. From the General pane, choose Job Notes.

In the Notes 1  and Notes 2  areas, enter user and job identification information for 

accounting purposes, or whatever information is required at your site. These notes will 

appear in the Job Log.

5. From the Job Notes pane, choose Printer Specific Options.

6. Specify the appropriate sett ings for the print  job.

These print options are specific to the Fiery XJ (you may need to scroll to see all the 

options). They override settings in Fiery XJ Printer Setup; the settings can also be 

changed in the Override Print Settings dialog box with the Fiery WebSpooler or 

Fiery Spooler. For information about these options and overrides, see Appendix A, 

“Print Options.”

If you choose Printer’s default , the Fiery XJ prints with the default setting specified 

during Setup.
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Some PPD options are ones that could also be set from an application (for example, 

Reverse Order printing or Collation). In these cases, use the PPD option to perform 

the function, rather than setting it from the application. The application may not set 

up the file properly for printing on the Fiery XJ and may also take longer to process.

7. I f  you want to make the new sett ings the default  sett ings, click Save Sett ings.

8. Click Print .

NOTE: The Fiery XJ does not support printing the Cover Page from the AdobePS 

printer driver.

Using Fiery Downloader to print

Downloading files with Fiery Downloader is generally faster than printing from 

application software. You can use Fiery Downloader to print PostScript or EPS files.

TO PRI NT USI NG FI ERY DOWNLOADER:

1. Create a PostScript  or EPS file. Specify the appropriate print  opt ions and include 

( embed)  any necessary fonts that  are not resident on the Fiery XJ.

For a list of fonts resident on the Fiery XJ, see Appendix B, “Font List.”

2. Launch Fiery Downloader and connect to the Fiery XJ.

For instructions on setting up Fiery Downloader, see Getting Started.

3. Select  the fi le( s)  you want to download, and specify any necessary options.

4. Click Download.

For details, see Chapter 5, “Downloading Files and Fonts.”
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You can print to the Fiery XJ directly from UNIX. Jobs printed to the Fiery XJ are sent 

to the Print queue and can be manipulated from Windows and Mac OS computers on 

the network using Fiery WebSpooler or Fiery Spooler.

The queue name and Fiery XJ printer name are established by your system 

administrator. Contact your system administrator for the names of your queues.

For information about setting up printing from TCP/IP, see your UNIX system 

documentation.

Print ing to the Fiery XJ

You can use UNIX commands to print PostScript files and text files to the Fiery XJ. In 

general, the basic print commands (lpr, lpq, lprm) can be used to send print jobs to a 

Fiery XJ. See your UNIX manual pages or other documentation for information about 

UNIX commands.

NOTE: Only PostScript or text file formats can be printed from UNIX. 

TO PRI NT FROM UNI X:

• On a system running SunOS 4.1.x or another BSD-based variant , use the lpr command 

to send a job to the Fiery XJ as follows:

lpr <-Pprinter> <-#co pies> <filename>

For example, if the Print queue of your Fiery XJ is named print_ Server, your file is 

named Sample , and you want to print two copies, type:

lpr -Pprint_ Server -#2 Sample
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• On a system running Solaris® 2 .x or any System V implementat ion of  UNI X, use the lp 

command to send a job to the Fiery XJ as follows:

lp -d <printername> { -n <#co pies>} <filename>

For example, if the Print queue of your Fiery XJ is named print_ Server, your file is 

named Sample , and you want to print two copies, type:

lp -d print_ Server -n 2 Sample

TO DI SPLAY A LI ST OF JOBS I N  THE QUEUE:

• On a system running SunOS 4.1.x or another BSD-based variant , use the lpq command 

to see printer jobs in the queue as follows:

lpq <-Pprinter>

For example, if the Print queue of your Fiery XJ is named print_ Server, type:

lpq -Pprint_ Server

Your workstation displays the contents of the queue.

• On a system running Solaris 2 or any System V implementat ion of  UNI X, use the lpstat  

command to see printer jobs in the queue as follows:

lpstat -o  <printername>

For example, if the Print queue of your Fiery XJ is named print_ Server, type:

lpstat -o  print_ Server

Your workstation displays the contents of the queue.
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TO REMOVE JOBS FROM THE QUEUE:

NOTE: Unless you log in as the ro o t user, you can remove only your own jobs. 

• On a system running SunOS 4.1.x or another BSD-based variant , use the lprm command 

to remove jobs from the queue as follows.

lprm <-Pprinter> <jo b #… >

You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your Fiery XJ named 

print_ Server, type:

lprm -Pprint_ Server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2.x or any System V implementat ion of  UNI X, use the 

cancel command to remove jobs from the queue.

cancel <printername> <jo b ID>

For example, to remove job number 123 from the Print queue of your Fiery XJ named 

print_ Server, type:

cancel print_ Server 123
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Fiery Downloader allows you to send PostScript and EPS files directly to the Fiery XJ 

without using the application in which they were created. It also enables you to 

manage printer fonts on the Fiery XJ. 

You can use Fiery Downloader from a remote Windows 95, Windows NT 4.0, or 

Mac OS workstation. Fiery Downloader requires a network connection—you cannot 

use Fiery Downloader with the parallel port. For information on supported 

networking protocols, see Getting Started.

NOTE: The Windows and Mac OS versions of Fiery Downloader are fundamentally the 

same; differences are noted in this chapter. Where a window or dialog box is illustrated, 

the Windows version comes first, followed by the Mac OS version.

Using Fiery Downloader

You can use Fiery Downloader to: 

• Send PostScript and EPS files to the Fiery XJ

• Check the status of the Fiery XJ

• Manage the PostScript printer fonts stored on the Fiery XJ hard disk (this feature 

requires that Publish Direct Connection is set to Yes in Fiery XJ Printer Setup)

NOTE: Fiery Downloader was designed specifically for the Fiery XJ; you cannot use it 

with any other printer. 

TO VI EW I NFORMATI ON  WI TH  FI ERY DOWNLOADER:

1. Launch Fiery Downloader.

2. Select  the Fiery XJ in the Chooser window and click OK ( Windows)  or Connect 

( Mac OS) .
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The Fiery Downloader Status window appears and you see the Fiery Downloader 

Toolbar, menus, and the status bar at the bottom of the screen. 

Buttons for some menu functions appear in the Toolbar at the top of the window:

Open Click to connect to a different Fiery XJ.

Download Click to download a file or font to the Fiery XJ.

Status If you are viewing the font list, click to display the 

status window for the current Fiery XJ. 

Font list If you are viewing the status window, click to 

display a list of printer fonts on the Fiery XJ hard 

disk.

About Fiery 

Downloader 

(Windows only)

Click to view version information about Fiery 

Downloader.

Displays server status and user 

and document name of  the job 

current ly print ing

Displays server status and user 

and document name of  the job 

current ly processing 

Dynamically displays the progress 

of  the job

Displays the amount of  available 

disk space
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You can click the Font list button or choose Font List from the File menu to view font 

information in the window.

3. To select  a dif ferent  Fiery XJ, choose Open from the File menu or click the Open 

button.

4. Select  the Fiery XJ in the dialog box that  appears, and click OK ( Windows)  or Connect 

( Mac OS) .

5. To close the connection to the Fiery XJ, make sure the Status window is act ive and 

choose Close from the File menu or click the close box in the Status window.

6. To quit  Fiery Downloader, choose Exit  ( Windows)  or Quit  ( Mac OS)  from the File menu.

Print ing with Fiery Downloader

Printing files with Fiery Downloader is fast—generally faster than printing from 

within applications. If you regularly print large files, try printing with Fiery 

Downloader.

TO DOWNLOAD A FI LE OR FONT WI TH  FI ERY DOWNLOADER:

1. Use your applicat ion to generate a fi le.

You can save a PostScript file by selecting the appropriate option in the application’s 

Print dialog box. With some applications, you can save EPS files.

If you experience problems printing EPS files with Fiery Downloader, you can print 

the file directly from the application in which it was created.

2. Launch Fiery Downloader.
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3. Choose Download from the File menu or click the Download button.

4. Choose the file type to display from the Files of  type ( Windows)  or Show ( Mac OS)  

menu.

You can leave this at the default All Known Formats or choose All Files. All Known 

Formats lists all files in formats supported by Fiery Downloader.

You can download files and fonts in the same batch. If the fonts are used by files in the 

same batch, the fonts should be downloaded first.
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To download fonts, you must use the Direct connection (make sure that Publish 

Direct Connection is set to Yes in Printer Setup on the Fiery XJ). If you do not have 

access to the Direct connection, you must embed any special fonts used by the file in 

the file when you generate it.

5. Choose the Connection Type ( Windows)  or Queue ( Mac OS)  to which you will download 

the files.

The options available to you in this menu depend on the Setup at your site. The 

potential selections are the Print Queue (Windows) or Print (Mac OS), or Direct 

Connection (Windows) or Direct (Mac OS). If your administrator has not enabled 

one or more of these connections, you cannot select it.

6. Select  the fi lename and click Add File( s)  ( Windows)  or Add ( Mac OS) .

The File name field (Windows) displays the name of the selected file before you click 

Add.

You can navigate to different drives and directories to select files to download. Click 

Add All (Mac OS) to add all files in a folder.

To select multiple sequential files, select the first file and then shift-click the last file. 

Control-click to select multiple non-sequential files.

If you change your mind about a file, select the filename in the Files to (be) 

Download(ed) list and click Remove File(s) (Windows) or Remove (Mac OS).

Click Remove All (Mac OS) to remove all files from the Files to Download list.

7. To change the attributes of  a fi le to be downloaded, select  i t  and click Options. 

8. Specify the following information in the dialog box and click OK:

The options you set apply only to the selected file. You can set different options, or 

leave the default settings, for each file.

Copies—Specify the number of copies to print.

Brightness—This option is not supported on the Fiery XJ.

‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) (EPS files only)—In 

most cases, you do not need to use this option. Select the ‘showpage’ option only if an 

EPS file fails to print without it. This option adds a showpage PostScript language 

command at the end of the print job. Some applications omit this necessary PostScript 
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language command when they generate EPS files. Select this option when printing 

EPS files generated by these applications. If you select this option unnecessarily, extra 

blank pages may print.

If you experience problems printing EPS files with Fiery Downloader, you can print 

the file directly from the application in which you created it.

9. Click Download File( s)  ( Windows)  or Download ( Mac OS) .

10. To cancel downloading, press Esc ( Windows)  or Command-. ( Mac OS) .

Downloading and managing printer fonts

The Fiery XJ includes 136 built-in PostScript fonts; for a complete list, see 

Appendix B, “Font List.” In addition, two Adobe Multiple Master fonts are included 

and are used for font substitution in PDF files.

NOTE: Publish Direct Connection must be set to Yes in Fiery XJ Printer Setup in order 

to download and manage fonts, and to view the font list.

Before downloading a file that uses fonts not resident on the Fiery XJ, you must 

download the fonts (unless the fonts are embedded in the file). To see what fonts are 

resident on the Fiery XJ, choose Font List from the File menu or click the font list 

button (see page 5-2).

You can download fonts only via the Direct connection. If you do not have access to 

the Direct connection, you must embed any special fonts used by the file in the file 

when you generate it.

The screen fonts that correspond to the printer fonts installed on the Fiery XJ are not 

automatically installed on your Windows system.

NOTE: You cannot use Fiery Downloader to download TrueType fonts. If you use 

TrueType fonts in Windows, you can print them by converting them to Adobe Type 1 

fonts. To do this with the AdobePS driver, click the Fonts tab and set up the Font 

Substitution Table as necessary. 
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Printer fonts and Mac OS screen fonts 

Like all PostScript fonts, the fonts included with the Fiery XJ come in two forms: 

printer fonts and screen fonts. The printer fonts are installed permanently on the 

Fiery XJ hard disk. The screen fonts should be installed on your Mac OS computer. If 

you are using these fonts in documents you print on another printer, they are probably 

already installed. If not, you will need to install them yourself.

Occasionally, you may want to use Adobe Type 1 (Windows) or PostScript (Mac OS) 

fonts that are not included with the Fiery XJ. If so, you will need to install the screen 

fonts on your computer and the printer fonts on the Fiery XJ. To do this, follow the 

instructions from the font manufacturer.

Downloading printer fonts to the Fiery XJ

In general, each time you print from within a Mac OS application, the application 

automatically downloads any fonts used in your document that are not already 

installed on the Fiery XJ, as long as the printer fonts are installed in your System 

Folder. These fonts remain in the Fiery XJ only until your document has printed. If 

you print the same document again, your application must download the fonts again.

If you regularly use one or more fonts from Windows or Mac OS applications that are 

not already installed in the Fiery XJ, you can save time by downloading them to the 

Fiery XJ hard disk with Fiery Downloader. Fonts you download to the Fiery XJ hard 

disk remain installed until you remove them using Fiery Downloader, no matter how 

many times the Fiery XJ is turned off and on. You’ll probably want to download fonts 

you use on a regular basis to the Fiery XJ hard disk.

Before you download files with Fiery Downloader, make sure that all fonts included in 

your file are installed in the Fiery XJ or embedded in your file; otherwise the text in 

these fonts will not print correctly and may not print at all.
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TO VI EW FONT I NFORMATI ON ,  UPDATE,  PRI NT,  AND DELETE FONTS:

• Choose Font List  from the File menu or click the Font List  button.

The Font List window appears with Update, Print, and Delete buttons in the title bar. 

The printer fonts included with the Fiery XJ (resident fonts) are locked. Locked fonts 

appear with a lock icon next to the name and cannot be deleted.

Click to update the information in

the font  list  window

Click to print  the font  list  to the Print  queue

Select  a font  and click to delete it

Lock icon
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Fiery XJ user software includes a variety of tools that allow you to track and manage 

print jobs. The particular tools, and the access privileges for them, that are available to 

you depend on the conditions implemented by your site administrator. This chapter 

describes the functions of Fiery WebTools and Fiery utilities that let you track and 

manage jobs sent to the Fiery XJ.

Tools for job tracking and management 

Depending on the workstation you use and the setup at your site, you may be able to 

choose between several Fiery XJ job tracking and management tools.

Fiery WebTools

If your site administrator has enabled Web Services on the Fiery XJ, you can access 

Fiery WebTools from Windows 95 and Windows NT 4.0 computers with an Internet 

browser. Fiery WebTools that provide job tracking capabilities are Fiery WebSpooler 

and the Status WebTool. Fiery WebSpooler also provides job management capabilities, 

provided you have the necessary access privileges (see page 6-2). For specific 

information on the browsers supported with Fiery WebTools, see Getting Started.

Fiery Spooler

Fiery Spooler, like Fiery WebSpooler, provides job tracking and job management 

capabilities. Fiery Spooler can be installed from the User Software CD on 

Windows 95, Windows NT 4.0, and Mac OS computers, and requires only a network 

connection to the Fiery XJ. If your network administrator has not enabled Web 

Services on the Fiery XJ, or if you do not have the necessary system support to use 

Fiery WebTools, you may choose to use Fiery Spooler for job management. For 

information on the system and network requirements for the Windows and Mac OS 

versions of Fiery Spooler, see Getting Started.

NOTE: The interface of Fiery Spooler for Windows is virtually identical to that of 

Fiery WebSpooler; therefore, the descriptions of both are combined into one section 

beginning on page 6-5. The interface of Fiery Spooler for Mac OS is significantly 

different from that of Fiery WebSpooler; it is described in detail starting on page 6-19.

Chapter 6:

Tracking and 

Managing 

Print  Jobs
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About Fiery WebTools

Fiery WebTools reside on the Fiery XJ but can be accessed over the network from 

Windows 95 and Windows NT 4.0 computers. The Fiery XJ has a home page from 

which remote users can select among the Fiery WebTools in order to view server 

functions, manipulate jobs, and download printer file installers. For specific 

information on the browsers supported with Fiery WebTools, see Getting Started.

The following Fiery WebTools can be accessed from the Fiery XJ home page.

Access privi leges

The Fiery XJ system allows the site administrator to choose and implement a level of 

access and control appropriate for your particular site. The levels of access allowed to 

remote users depend on whether the administrator has enabled use of the 

Fiery WebTools, and whether a password is required to use certain features of the 

Fiery WebTools.

WebTool: Summary: For more information:

Status Shows you the jobs currently processing 

and printing.

See page 6-4

WebSpooler Allows you to view, manipulate, reorder, 

reprint, and delete jobs currently 

spooling, processing, or printing on the 

Fiery XJ. Also allows you to view, print, 

and delete the Job Log. Most of these 

functions require an Administrator 

password, if one has been set.

See “Fiery WebSpooler and 

Fiery Spooler for Windows” on 

page 6-5

Installer Allows you to download Fiery XJ printer 

file installers directly from the server.

See Getting Started
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The two possible levels of access to Fiery WebTools are Administrator and Guest. 

When an Administrator password has been specified, the access levels are as follows:

TO ACCESS FI ERY WEBTOOLS:

1. Start  up your I nternet  browser applicat ion.

See Getting Started for information about supported platforms and browsers.

2. Enter the I P address or the DNS name of  the Fiery XJ.

Check with the administrator for this information.

3. I f  the Log I n dialog box appears, enter the password and click OK.

The Log In dialog box appears only if an Administrator password has been set.

Access level: Privi leges and password requirements:

Administrator Has full access to all Fiery WebTools and Fiery XJ Control Panel 

functions; Administrator password required

Guest Can view job status, but cannot make changes to jobs or Setup, 

and cannot view the Job Log; no password required
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4. When the Fiery XJ home page appears, click to select  one of  the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.

NOTE: The Configure button appears only if you logged in as Administrator. With 

Administrator privileges, you can click this button and specify which of the 

Fiery WebTools are available to other users.

Checking Fiery XJ status with the Status WebTool

You can use the Status WebTool to see what jobs are currently processing and printing. 

The Status WebTool does not require any special access privileges. If the administrator 

has enabled Web Services in Setup and has provided you with the IP address of the 

Fiery XJ, you can use the Status WebTool to monitor the status of print jobs as they are 

rasterized and printed. 
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To access the Status WebTool, point your browser to the Fiery XJ home page and click 

Status. The current RIP Status and Printer Status appear in the window.

To open a new browser window for the Status display, click Float. You can then close 

other browser windows and leave the Status window open to continue checking the 

status of the Fiery XJ. As long as you keep the Status window open, it is dynamically 

updated.

To obtain more information about the status of jobs, use Fiery WebSpooler or 

Fiery Spooler.

Fiery WebSpooler and Fiery Spooler for Windows

Fiery WebSpooler and Fiery Spooler for Windows both provide a window on Fiery XJ 

and copier functions, and an interface from which you can control those functions.

NOTE: After launching, the Fiery WebSpooler and Fiery Spooler for Windows 

interfaces are virtually identical. Following the explanations of how to launch each 

tool, the remainder of this section uses the term “Fiery WebSpooler” to refer to both 

Fiery WebSpooler and Fiery Spooler for Windows. Where differences exist between the 

two, they are noted.
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TO LAUNCH  FI ERY WEBSPOOLER:

1. From the Fiery XJ home page, click WebSpooler.

For instructions on how to access the Fiery XJ home page, see page 6-3. 

2. To log in as Administrator, enter the Administrator password and click OK.

To log in as Guest, click OK, without entering any password.

The Fiery WebSpooler window appears in a new browser window.

TO LAUNCH  FI ERY SPOOLER ON  A WI NDOWS COMPUTER:

1. Choose Fiery Spooler from the Start > Programs menu.

2. Select  the Fiery XJ in the Chooser window that  appears.

For information on setting up the connection to the Fiery XJ, see Getting Started.
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3. Click OK.

Job management features

Unless a password has been defined in Fiery XJ Setup, you can log in to 

Fiery WebSpooler without entering a password, and you are given full privileges which 

include:

• A view of current printing jobs and jobs stored on the Fiery XJ

• Control of printing jobs and a view of the Job Log

• Ability to clear the Job Log

After the Administrator has performed Setup and specified the password, user options 

depend on your login level. If you log in to Fiery WebSpooler as Guest, you have the 

first option only. If you log in as Administrator, you have all three options. For 

information about Setup and specifying passwords, see the Administrator Guide.
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You can use Fiery WebSpooler to perform the following functions from your 

workstation:

• Override current job option settings

• Delete jobs 

• Duplicate or rename jobs

• Change the priority of jobs

• Display, print, or delete the Job Log 

Most of these functions require the Administrator password. However, even without a 

password, you can log in to Fiery WebSpooler as Guest with view-only privileges.

Job List  window

Your first view of Fiery WebSpooler is the Job List window, which is divided into three 

areas by Spool, RIP, and Print status bars. The Job List window is surrounded by a 

frame that includes slider buttons and menus. System information indicators at the 

bottom of the window show the current availability of hard disk space and RAM on 

the currently selected Fiery XJ.

When the Fiery XJ is receiving and processing print jobs, the Job List window is a 

dynamic display, filled with the names of jobs and their characteristics. Status bars 

animate in real time as new jobs are processed and printed, and jobs move to different 

display areas.
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The Spool, RIP, and Print areas of the Job List window represent the stages of printing 

a job. Jobs come in at the top level (Spool) and drop down to the Print level, unless 

they are held along the way.

• Spooled jobs—Jobs listed in the area below the Spool status bar area are PostScript 

files stored on the Fiery XJ disk. These jobs were sent to the Print queue. These 

PostScript files are saved on the server’s hard disk. PostScript files can come in 

packets from the network, or from another place on the server hard disk. Jobs are 

added to a queue in the order in which they arrive, and they generally move to 

another queue in the same order unless someone has intervened to change the order.

• RI Pped jobs—Jobs listed in the area below the RIP status bar are ready to print. 

They have already been rasterized (RIPped, or processed for printing) and are 

waiting, in order, for access to the printer. During RIPping, PostScript commands 

are interpreted in the Fiery XJ to allow the copier to print the file the way its 

originator intended. 

Spool status bar

RI P status bar

Rasterized ( RI Pped)  jobs

Print  status bar

Printed jobs

Spooled jobs

Menu bar

System information indicators
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The result of this interpretation is a raster file associated with the original PostScript 

file. In this raster file (raster image), color data is associated with each dot that can be 

rendered by the print engine. The color data tells the print engine whether or not to 

apply cyan, magenta, yellow, or black toner to each position on the page.

• Printed jobs—Jobs listed in the area below the Print status bar have already been 

printed. Printed jobs can be stored on the Fiery XJ disk. The number of jobs that 

can be stored (from 1 to 99) is defined in Setup. 

• Errors—Jobs with an error are shown in red. To display the error, double-click the 

job line.

If you are logged in as Administrator, you can interact with a job in the window by 

selecting it and choosing a command from the Job menu, or by double clicking it and 

setting print option overrides. (However, if a password has been set and you are logged 

in as Guest, you can only view jobs; you cannot interact with them.)

The job icons displayed in the Fiery WebSpooler window are explained on page 6-12.

NOTE: If your job does not appear anywhere in the Fiery WebSpooler window, it may 

have already been printed; if so, it will appear in the Job Log. To view the Job Log, 

choose Show Job Log from the Window menu. (For more information on the Job Log, 

see page 6-16.)

Menu bar

The menu bar has four menus. When an action is not available in the current context, 

the command is dimmed.

Menu: Choose this: To do this:

File Print Job Log Print the Job Log

Delete Job Log Delete the Job Log

Export Job Log Save the Job Log as a text file

Open Fiery Launch Fiery WebSpooler for a different Fiery XJ

Exit Log out from the server and exit Fiery WebSpooler
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Status bars

Jobs actively involved in the three processes (spooling, rasterizing, and printing) are 

listed in the status bars that span the Job List window.

Status bars show the filename and user name for the active process, and an indication 

of its progress. Each status bar heads the list of jobs that have completed the process. 

Thus, beneath the Spool status bar, you see a list of spooled files; beneath the RIP 

status bar, you see a list of rasterized (RIPped) files. Beneath the Print status bar, you 

see a list of jobs that have already been printed.

NOTE: In the Spool status bar, the filename and user information always appear as 

“Unknown” (as shown below). This information is not available until the job has 

finished spooling to the Fiery XJ disk.

Job 

(For more 

information on 

these commands, 

see page 6-14)

Delete Job(s) Delete one or more selected jobs

Duplicate Job(s) Duplicate one or more selected PostScript data jobs in the Spool or Print areas

Rename Rename a selected job

Print Print the selected job(s); see page 6-13

Process Next Give top priority to this job

Override Print 

Settings

View and edit print settings for the selected job(s); see page 6-15

Window Show Job List Show the Job List window

Show Job Log Show the Job Log window

Help About View the Fiery WebSpooler information screen

Menu: Choose this: To do this:
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Job icons

There are two types of icons that are used for active jobs:

Spool area

The job icon in the Spool area is described below: 

The Spool area is the waiting area for jobs that will be RIPped (jobs in the Spool 

queue).

Print  queue jobs  Network jobs sent to the Print queue appear in the Spool area 

where they are shown with a white printer icon. When they reach the head of the 

queue, they are RIPped and printed.

Direct  connection jobs  Jobs printed to the Direct connection are not displayed in the 

Fiery WebSpooler job lists. They are displayed briefly in the status bars (where they 

cannot be selected) and are included in the Job Log.

I con:
Active jobs:

( white icons)

PostScript icon

PostScript data after printing, raster 

deleted

Printer icon

PostScript or raster data headed for 

printing

Spool area icon: What it  indicates: How long you see the job:

White printer icon

PostScript data headed for 

Print

Until the RIP is free
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RI P area

The job icon in the RIP area is described below: 

After a job is rasterized, it goes into the RIP area. The RIP area holds only raster data 

(i.e., jobs that have been rasterized). Jobs in the RIP area are waiting for the copier to 

be free.

NOTE: Raster jobs in the RIP area that are waiting to print cannot be manipulated by 

job commands.

Print  area

The job icon in the Print area is described below:

The Print area, also referred to as the Printed queue, contains jobs that have already 

been printed.

NOTE: A job row that appears in light red indicates that a PostScript error occurred 

while printing the job. To see the error, double-click anywhere in the row.

Newly printed jobs are added to the Printed queue, and are shown at the top of the list. 

Jobs are saved in the Printed queue until the job limit is reached. When the first job 

over the limit is printed, the oldest job is deleted from the disk. The default job limit is 

10 jobs. The value for Jo bs Saved in Printed Queue can be changed in Setup by the 

administrator.

RI P area icon: What it  indicates: How long you see the job:

White printer icon

Raster data headed for Print 

in its turn

Until copier is free to print 

the job

Print  area icon: What it  indicates: How long you see the job:

White PS icon

PostScript data only—raster 

data has been deleted

Until the job limit is reached
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NOTE: If you reprint a job in the Printed queue, the job returns to its original position 

in the Printed queue after it is printed.

While it is printing, a job consists of PostScript and raster data; jobs with only 

PostScript data remaining are represented by a white PS icon.

Job commands

Using the commands in the Job menu, you can alter the destinations, priorities and 

other characteristics of jobs that appear in the Fiery WebSpooler window.

Job commands are used to assign a selected job to a new destination or process. These 

commands are available from the Job menu (see page 6-10). The job commands 

available at a given time depend on the context; unavailable commands are dimmed. 

The job commands available for selected jobs in the Job List window are listed in the 

following table.

Choose this: To do this:

Delete Job(s) Delete the job(s) 

Duplicate Job(s) Duplicate one or more selected PostScript 

data jobs in the Spool or Print areas. You can 

use the duplicate job(s) for different print 

options or a different destination. (The 

Duplicate command actually creates a 

reference to the original job, with the same 

name)

Rename Rename the job (PostScript file)

Print Print the job in its turn

After printing, keep the printed job in the 

Print area until the job limit is reached.

Process Next Give top priority to this job

RIP (and then print) it as soon as the 

processor is free, before other waiting jobs

Option is dimmed if there are no other 

waiting jobs
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Overriding print  sett ings

When logged in as Administrator, you can use the Override Print Settings command to 

check and override the print option settings (properties) of all jobs.

You can use this command for several purposes:

• To override a setting based on printed output or other print device conditions

• To change settings for a duplicate of the original job

• To print a single copy of a job before printing the number of copies required by the 

user

To change the print settings for a job, double-click the job line or select the job and 

choose Override Print Settings from the Job menu.

Override Print Settings View and override print settings for a 

selected job or a group of selected jobs

Choose this: To do this:
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The options you set here are the same ones you set from the Print dialog box when you 

print from an application. For information about print options, see Appendix A, 

“Print Options.”

If you want to retain a copy of the job with its original settings, duplicate the job and 

rename the duplicate before you change any settings (see “Job commands” on 

page 6-14). 

The Override Print Settings dialog box displays all the job settings encoded by the 

PostScript printer driver that can be decoded by the Fiery XJ. If you (as operator) have 

not changed anything, these are the settings a user entered before sending the job.

For information on print option settings, see Appendix A, “Print Options.”

Using the Job Log

From Fiery WebSpooler, you can view and print a log of all jobs printed by the 

Fiery XJ, including jobs downloaded with Fiery Downloader. You can also save the Job 

Log to a text file which you can then import into a spreadsheet or word processing 

application for job accounting purposes.

NOTE: If you logged in as Administrator, you can delete the Job Log from 

Fiery WebSpooler (see page 6-18). The Job Log is not available if you logged in as 

Guest.

TO DI SPLAY,  UPDATE,  PRI NT,  DELETE,  AND SAVE THE JOB LOG:

1. Choose Show Job Log from the Fiery WebSpooler Window menu.
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2. Click All or specify a date range.

3. Click OK.

The Job Log appears in a new browser window.

The Job Log displays each job and the following information: status, document name, 

user name, date, start time, end time, process time, file size, device, paper size, media, 

number of originals, number of color pages, number of black-and-white pages, total 

number of pages, Note1, and Note2.

Update

Print

Delete
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The Status column provides the following information about jobs:

4. To update the Job Log, click the Update button.

5. To print  the Job Log, choose Print  Job Log from the File menu or click the Print  

button.

The information displayed in the Job Log window prints to the current Fiery XJ. 

When you print the Job Log, totals are printed for all appropriate columns.

6. To clear the Job Log, choose Delete Job Log from the File menu or click the Delete 

button.

The system administrator can also print and clear the Job Log from the Control Panel.

Differences between Fiery WebSpooler and Fiery Spooler for 
Windows 

Though the interfaces for both Fiery Spooler for Windows and Fiery WebSpooler are 

almost identical, there are some feature differences.

Connecting to a dif ferent  Fiery XJ

With Fiery Spooler, you can connect to a different Fiery XJ from within the 

application using the following procedure.

TO CONNECT TO A DI FFERENT FI ERY XJ:

1. Choose Open Fiery from the File menu.

2. Select  the Fiery XJ in the Chooser window that  appears.

For information on setting up the connection to the server, see Getting Started.

3. Click OK.

The Fiery Spooler main window appears.

OK The job was printed normally.

ERROR An error occurred during processing or printing.

CANCEL The job was canceled before printing was completed.
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Saving the Job Log as a fi le

With Fiery Spooler, you can save the Job Log as a file that you can view with a different 

application.

TO SAVE THE JOB LOG AS A FI LE:

1. Choose Export  Job Log from the File menu or click the Export  button at  the top of  the 

Job Log window.

2. I n the File name area, enter a name for the Job Log file ( the default  name is 

Fiery Job Log.txt) .

3. Browse to the locat ion where you want to save the fi le, and click Save.

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 

separated by tabs.

Fiery Spooler for Mac OS computers

For Mac OS computers, the Fiery Spooler interface and functionality differ from 

Fiery WebSpooler, and the Windows version of Fiery Spooler.

On a Mac OS computer, Fiery Spooler jobs can be in one of the following queues:

Jobs in the queues are stored on the Fiery XJ hard disk. Make sure that you leave 

enough space on the hard disk for fonts and other Fiery Spooler jobs.

Print Normal print jobs sent to the Fiery XJ appear in the Print queue. You 

can move and manipulate these jobs as described below.

Printed The jobs most recently sent to the Fiery XJ are saved in the Printed 

queue. You can drag these jobs back to the Print queue to print 

additional copies. The number of jobs saved in the Printed queue is set 

by your system administrator in Fiery XJ Setup.

Export  button
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You can use the Fiery Spooler Job Log to view information about jobs printed to the 

Fiery XJ for job accounting purposes, or saved for reference. The Job Log can be 

printed to the Fiery XJ or saved as a file and viewed in other applications.

TO LAUNCH  FI ERY SPOOLER ON  A MAC OS COMPUTER:

1. Double-click the Fiery Spooler icon.

2. I f  your network is divided into zones, select  the zone in which the Fiery XJ is located.

3. Select  the Fiery XJ from the list  of  servers that  appears, and click Connect.

The Fiery Spooler main window appears.

4. To access Administrator funct ions, choose Password from the Administrator menu.

This menu is active only if a password was created on the Fiery XJ.

Current Print  and RI P status

Name of  the job current ly 

print ing

Scroll list  of  every document 

sent to the Print  queue

Jobs with PostScript  errors 

appear in Printed queue with 

Alert  icon

Name of  the job current ly 

processing

Server name or I P address 

of  Fiery XJ

Available space on 

Fiery XJ hard disk
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5. Enter the password in the window that  appears, and click OK.

The job list

The job list includes information about the document name, user name, time and date 

sent, print device, and file size.

The window is split into regions that correspond to the different queues and steps in 

the printing process. You can click and drag a job to the Print region of the window to 

move it to the corresponding queue.

Buttons appear above the scroll list. The buttons are:

Update Click to update the information in the Fiery Spooler 

main window.

Duplicate 

and Print

Drag a document onto this button or select the document 

and click to duplicate it and put the duplicate in the Print 

queue.

Print Drag a document onto this button or select the document 

and click to print it to the Print queue.

Hold This queue is not enabled on the Fiery XJ. If you drag a 

document onto this button, or select the document and 

click this button, you will receive a Warning message.

Delete/

Cancel

Drag a document onto this button or select the document 

and click to delete it or cancel processing or printing it. 

You will be asked to verify that you want to delete the job. 

You can eliminate the verification notice by turning off 

the Confirm file delet ion option in the Preferences dialog 

box.
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The icons provide information about the job:

Choose Preferences from the Edit menu to configure how the Fiery XJ updates and 

deletes files.

You can use this window to specify that the Fiery XJ:

Printing Printing icon The job that is currently printing appears in this list; it can be selected 

and deleted to cancel printing.

Waiting Printing icon Jobs that have been processed and are waiting to print appear in this 

list, but they are dimmed because their settings cannot be changed 

and they cannot be moved or canceled.

Ripping RIP icon Jobs that are processing appear in this list; they can be selected and 

deleted to cancel processing.

Print Print icon Jobs that have not been processed appear in this list, in the order they 

will be processed and printed. The jobs can be selected and deleted to 

cancel processing and printing.

Printed Printed icon Jobs that have been printed are saved in this list. Jobs are stored in the 

Printed queue until the limit set by your system administrator in 

Fiery XJ Setup is reached. The jobs can be selected and deleted from 

the Fiery XJ hard disk.

Printed Alert icon If a PostScript error occurred while a job was printing, it appears in 

the Printed queue with an Alert icon (the Printed icon with a red 

slash) next to it. You can double-click the Alert icon to display the 

error message. The jobs can be selected and deleted from the Fiery XJ 

hard disk.
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Update Automatically every n seconds or Update Manually—This option lets you 

specify whether the Fiery Spooler main window is automatically updated every 20 

seconds (or at an interval that you set), or whether it is updated only when you choose 

the Update command from the Window menu. By default, the Fiery Spooler main 

window is updated automatically every 20 seconds.

NOTE: When automatic updating is on, data is coming from the Fiery XJ across the 

network very frequently. This data adds to the network traffic, and may slow down 

other network jobs. For optimum network performance, turn off automatic updating 

in the Fiery Spooler Preferences dialog box; when you want to view updated 

information in the Fiery Spooler window, choose Update from the Window menu or 

click the Update button.

Confirm file delet ion—Select this if you want a confirmation dialog box to appear 

before you delete a file.

Duplicat ing, copying, moving, and delet ing jobs

Users are able to monitor their own print jobs. The Fiery XJ system administrator (or 

anyone with Fiery Spooler Password access) can move, delete, and configure jobs for all 

users, and can re-order jobs within a queue.

You can move your jobs from the Printed queue to the Print queue. By copying rather 

than moving a job, you leave a copy of the job in the Printed queue so that you can 

print the job again later. You can also duplicate a job if you want to have multiple 

copies of a job in the same queue.

Duplicat ing jobs

You can duplicate jobs in the Print and Printed queues:

• If you want to change printing parameters in the Override Print Settings dialog box 

without losing the original settings

• If you want to print more than 15 copies to the sorter (the maximum number of 

copies that you can print to the sorter is 15)
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When you duplicate a job, the Fiery XJ creates a reference to the original file, so 

duplicate files do not require the full amount of disk space on the Fiery XJ. As long as 

one of the duplicates remain, the Fiery XJ saves the file, so you can delete all but one 

reference to a file.

TO DUPLI CATE A JOB WI THI N  A QUEUE: 

1. Select  the job that  you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 

select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 

jobs.

2. Choose Duplicate Job( s)  from the Edit  menu.

The job appears at the bottom of the queue. 

TO DUPLI CATE AND PRI NT A JOB: 

1. Select  the job that  you want to copy by clicking its name. 

The selected job is highlighted.If you want to select more than one job, shift-click to 

select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 

jobs.

2. Click the Duplicate and Print  button, or drag the job to the Duplicate and Print  button.

The job appears at the bottom of the Print queue. 

TO COPY A JOB TO ANOTHER QUEUE:

1. Select  the job that  you want to copy by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 

select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 

jobs.

2. Hold down the Option key as you drag the job to Print  queue icon or to the Print  

sect ion of  the job list .

A copy of the job is moved to the Print queue, but the original job still appears in the 

Printed queue so that you can print the job at another time.
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TO MOVE A JOB WI THI N  A QUEUE:

1. Select  the job that  you want to move by clicking its name. 

The selected job is highlighted. If you want to select more than one job, shift-click to 

select multiple, adjacent jobs; control-command-click to select multiple, non-adjacent 

jobs.

2. Drag the file to the new locat ion in the queue.

TO DELETE A JOB FROM ANY OF THE QUEUES:

1. Select  the job that  you want to delete by clicking its name.

2. Drag the selected job to the Delete button or click the Delete button.

You can also choose Delete Job(s) from the Edit menu.

System administrators (or anyone with Fiery Spooler Password access) can delete any 

job.

Changing print  sett ings for a job

You can set certain print settings for a job in the Override Print Settings dialog box. 

The settings in this dialog box override the settings in the Printer Specific Options 

dialog box and in Fiery XJ Setup.

You can change print settings only for jobs in the Print and Printed queues of the Fiery 

Spooler main window.

System administrators (or anyone with Fiery Spooler Password access) can change print 

settings for any job.

NOTE: The Override Print Settings dialog box may not reflect the entire set of print 

options that are available from the printer driver.
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TO CHANGE PRI NT SETTI NGS FOR A JOB:

1. Double-click a job or select  the job and choose Override Print  Sett ings from the Edit  

menu.

The Override Print Settings dialog box appears.

2. Choose the new sett ings from the pop-up menus.

If you leave a setting at Default  Sett ings, the job will use the settings in the Printer 

Specific Options dialog box.

For information about these options, see Appendix A, “Print Options.”

3. Click OK to make changes.

Using the Job Log

With Fiery Spooler, you can view and print a log of all the jobs printed to the Fiery XJ. 

You can also save the Job Log as a text file that you can then import into a spreadsheet 

or word processing application for job accounting purposes. All jobs printed to the 

queues and printed by direct connection are listed in the Job Log.
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TO DI SPLAY,  UPDATE,  PRI NT,  SAVE,  AND DELETE THE JOB LOG:

1. Choose Show Job Log from the Window menu.

2. Specify the period for the Job Log in the window that  appears.

Click All to view all jobs since the Job Log was cleared; click Date if you want to specify 

a period of time for the Job Log.

3. Click OK.

The Job Log window displays a list of all the jobs and the following information about 

them: status, document name, user name, date, start time, end time, process time, file 

size, print device, paper size, media, number of originals, number of color pages, 

number of black and white pages, total number of pages, Notes 1, and Notes 2.

The information in the note fields is specified in the Print dialog box if you are using 

the AdobePS printer driver. 

Use the scroll bar at the bottom of the window to view all fields in the Job Log 

window.

Update

Print

Export

Delete
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The text in the Status column provides information about the job:

4. To update the Job Log, click the Update button at  the top of  the window.

5. To print  the Job Log, choose Print  Job Log from the File menu or click the Print  button 

at  the top of  the window.

The information displayed in the Job Log window prints to the current Fiery XJ. 

When you print the Job Log, totals are printed for all appropriate columns.

6. To save the Job Log as a fi le that  you can view with a dif ferent  applicat ion, choose 

Export  Job Log from the File menu or click the Export  button at  the top of  the window. 

Enter a name for the log file, and click Save. 

The Job Log is saved as a text file, and the Job Log window reappears.

You can view the information in any application that can read a text file. Items are 

separated by tabs.

7. I f  you entered the Administrator password, you can choose Delete Job Log from the 

File menu to clear the Job Log. 

The system administrator can also print and clear the Job Log from the Control Panel.

OK The job was printed normally.

ERROR A PostScript error occurred while a job was processing. You can 

double-click ERROR to display the error message. A dialog box 

displays the PostScript error. Click OK to close the dialog box.

CANCEL The job was canceled before printing was completed.
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Calibrating the Fiery XJ ensures consistent, reliable color output. You can calibrate the 

Fiery XJ by using AutoCal from the Fiery XJ Control Panel. AutoCal allows you to 

obtain measurements from the copier and apply a calibration using the copier’s built-in 

scanner. 

I ntroduction

A calibration is generated from two components that originate separately: 

measurements and a target. 

• Measurements represent the actual color behavior of the copier; they are computed 

from readings taken by the copier’s scanner.

• Targets represent the goal of printing, such as obtaining pleasing color from the 

copier or simulating another print device. A copier-specific target is provided with 

the Fiery XJ.

Calibration generates curves describing various color densities based on a specified 

target and a set of measurements that you provide.

Once you have calibrated the Fiery XJ, a calibration is stored on the Fiery XJ; this 

calibration is referred to as the resident calibration. The resident calibration is applied to 

all print jobs.

NOTE: Changing the resident calibration has the potential to affect all jobs for all users, 

so you may want to limit the number of people authorized to perform calibration. An 

Administrator password can be set to control access to calibration from the Fiery XJ 

Control Panel.

Understanding calibrat ion

The Fiery XJ allows you to choose between two standard calibrations. A standard 

calibration uses one of the targets provided with the Fiery XJ (r2 or Linear) with a new 

set of measurements.

Chapter 7:

Color Calibration
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Calibration allows you to:

• Maximize the color reproduction capabilities of the Fiery XJ

• Ensure consistent color quality across time

• Produce consistent output across Fiery XJ servers of the same engine

• Optimize the Fiery XJ for using ColorWise Color Rendering Dictionaries (CRDs) 

and CMYK simulations, and for using ICC-compatible profiles when printing RGB 

color data

• Linearize the Fiery XJ while maintaining the currently available density range

How calibrat ion works

Success in obtaining satisfactory print quality from a digital color printer depends on 

many factors. Among the most important are establishing and maintaining optimal 

toner densities. Density is a measure of the light absorbed by a surface. By carefully 

regulating toner densities, you can obtain consistent printed color. 

Even with a calibrated system, toner density is affected by such variables as room 

humidity and service settings; it also tends to drift over time. Regular measurement 

detects day-to-day variations in densities, and calibration corrects for them.

Calibration works by creating calibration curves on the Fiery XJ that compensate for 

the difference between actual and desired density values. 

Calibration curves and target curves are the graphic equivalent of transfer funct ions, 

which are mathematical descriptions of changes that will be made to the data with 

which you start. Transfer functions are often graphed as Input/Output curves.

Target curves (targets, for short) result from applying one or more transfer functions in 

sequence. The server generates calibration curves after comparing measured values to 

the final target values for each of the four toner colors.

Measurements

Measurements files contain numerical values that correspond to the toner density 

produced by the copier when it prints solid cyan, magenta, yellow, and black, and 

graduated tints of those colors.
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To create a measurements file, you first print a page of color patches from the Control 

Panel. Then you measure the patches, using the copier’s scanner. The new 

measurements are automatically downloaded to the Fiery XJ.

You can print a calibration Comparison Page showing the result of using the new 

measurements with any of the current targets. When you are satisfied with a particular 

combination of measurements and target, you apply the calibration to the Fiery XJ; 

this becomes the new resident calibration. 

Targets

Target files define desired calibration results. Two target files are provided with the 

Fiery XJ. When you calibrate the Fiery XJ, you can select the target file that 

corresponds to the typical printing goals at your site. This becomes the resident 

calibration target that is used by default.

The calibration targets provided with the Fiery XJ are:

• r2—Optimized for best results with the copier.

• Linear—Results in output that divides the maximum measured density for each 

color into equal density steps to provide an even distribution of tones over the 

copier’s density range. When you linearize the printer, the entire measured density 

range in each color channel is divided into equal steps. Equal steps in toner 

percentage, such as 0%, 10%, and 20%, are printed in equal steps in density, and 

appear as roughly equal visual steps. This gives a linear response using the range of 

densities available.

Scheduling calibrat ion

In general, you should calibrate the Fiery XJ at least once a day, depending on the 

volume of print jobs. If it is very important to maintain consistent colors, or if the 

copier is subject to wide fluctuations in temperature or humidity, calibrate every few 

hours. Calibrate when you change paper stock. In general, to get the best performance 

from the copier, calibrate whenever there is a noticeable change in print quality.

If you need to split a print job into two or more batches, it is especially important to 

calibrate before printing each batch.
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You should also calibrate the Fiery XJ system after copier maintenance. However, 

because the copier may be less stable immediately after maintenance, wait until you 

have printed approximately 50 pages before you calibrate.

NOTE: Output from the copier is very sensitive to changes in temperature and 

humidity. To minimize these effects, the copier should not be installed near a window 

or in direct sunlight, or near a heater or air conditioner. Paper is sensitive to climate 

changes as well, and should be stored in a cool, stable environment.

The copier has a self-calibration feature (Auto Color Calibration, or ACC) that 

optimizes toner densities after scanning a test print on the copier glass. If you never 

calibrate the Fiery XJ from the Control Panel, the self-calibration feature can improve 

the color output of print jobs. Using the copier’s self-calibration feature alone will not 

necessarily bring output densities from the copier to the optimal values for Fiery XJ 

printing. However, if you regularly calibrate the Fiery XJ, your print jobs can 

sometimes be improved by asking a service technician to disable the copier’s self-

calibration feature.

The copier allows you to adjust printed color from its touch panel display. You can 

typically increase or decrease toner density for one or all toner colors. These control 

panel settings affect copies made from the copier glass, and may affect Fiery XJ output 

as well. If they do, make sure these settings remain the same (preferably at a neutral 

position) prior to calibration, and from one print job to the next. If you change these 

settings, calibrate the Fiery XJ when you have finished changing settings.

Print some standard color pages. Images with skin tones offer a very good basis for 

comparison. You can save and compare pages you printed at different times. If there is 

a noticeable change in appearance, you should calibrate or linearize the Fiery XJ 

system.

If the solid density patches (100% cyan, magenta, yellow or black) look less saturated 

with time, show the pages to the copier technician to find out whether adjusting the 

copier can improve the output.
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Checking calibrat ion status

You can check whether the Fiery XJ is calibrated, what target was used, and when the 

printer was last calibrated. You can view information about the last calibration by 

printing a Configuration page or Test Page from the Control Panel.

Calibrat ing with AutoCal from the Control Panel

You can calibrate the Fiery XJ from the Control Panel using AutoCal, which calibrates 

the Fiery XJ using the copier’s built-in scanner as a densitometer. If an Administrator 

password has been set, you will need it for calibration.

For instructions on using the Fiery XJ Control Panel, and for more details on the 

AutoCal options, see the Administrator Guide.

For information on error messages you may see during the AutoCal procedure, see 

“AutoCal error messages” on page C-9.

NOTE: You will need the Kodak Gray Scale strip that came in the media pack with your 

Fiery XJ.

TO ACCESS AND USE AUTOCAL:

1. Reboot the Fiery XJ, and be ready to press a button at  the Control Panel short ly after 

startup diagnostics.

2. Press any key when the Fiery XJ message “For software update or setup, press any 

key.” appears.

3. Choose Run Setup.

4. Choose Calibrat ion, and choose Set  Up Calibrat ion.

5. For Tray, choose the paper source for the patch page.

6. Choose Calibrate.

The Select Target screen appears.

7. Select  the target .
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8. When prompted, select  Yes to print  the measurement page.

This page is comprised of swatches of color that will be measured by the copier and 

then compared to the target color values.

After the page is printed, the Measure Page screen is displayed.

NOTE: The measurement page printed from the Control Panel is printed in the copier’s 

Photo mode (for Photo mode calibration). If you want to print a measurement page in 

the copier’s Letter mode (for Letter mode calibration), download the file “Letter.ps” 

from the User Software CD. This file is located in the Color\Calib folder (Windows) 

or the Color:Calibration folder (Mac OS).

9. Select  Yes in the Measure Page screen.

10. When prompted on the Control Panel, place the Kodak Gray Scale strip face down along 

the top of  the copier glass.

11. Place the color measurement page face down over the grayscale strip.

Align the top-left corners of the grayscale strip and the color measurement page with 

the arrow at the top-left corner of the copier glass.

Make sure the patches on the grayscale strip do not overlap the color patches.

12. Close the copier lid, being careful not  to move the grayscale strip and color 

measurement page.

13. Click OK.

Status messages display the progress of scanning and calculating measurements.

14. When prompted to Print  Comparison Page, select  Yes.

This page provides you with a preview of the selected calibration.

15. When prompted to overwrite calibrat ion, select  Yes.

�� ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ����@@��ÀÀ��@@��ÀÀ��@@��ÀÀ��@@��ÀÀ�� Place color measurement page face

down over grayscale strip

Place grayscale strip 

face down
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16. Select  Yes to confirm.

Status messages display progress information. The new calibration becomes the 

resident calibration.

17. When calibrat ion is complete, choose Exit  Calibrat ion. 

This automatically restarts the Fiery XJ.

Removing calibrat ion

It is also possible to remove calibration from the Fiery XJ. In general, it is not necessary 

because any new calibration replaces the existing one.

TO REMOVE CALI BRATI ON  FROM THE CONTROL PANEL:

1. From the Control Panel, access the Calibrat ion menu as described on page 7-5.

2. Choose Remove Calibrat ion.

3. When prompted, verify that  you want to proceed with removing calibrat ion.

The current calibration curves are removed, and a default calibration is restored.

Working with simulat ions

Simulations, or press simulations, allow you to use the copier as a proofing device for 

jobs that will print on an offset press. Because the range of colors available on the 

copier is different from that of a press, the Fiery XJ automatically adjusts the color so 

that the output falls within the range of colors a press can produce.

Three simulation target files are provided with the Fiery XJ user software. These files 

enable you to load targets for the following press standards:

• DI C—Japanese press standard

• Euroscale—European press standard

• SWOP-Coated—US press standard
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Changing simulat ion targets

By default, the Fiery XJ is loaded with the SWOP-Coated simulation target. You can 

change the simulation target by downloading special files from the User Software CD 

to the Fiery XJ.

NOTE: Changing the simulation target on the Fiery XJ also resets the default Rendering 

Style setting to Presentation.

TO CHANGE THE SI MULATI ON  TARGET:

1. I nsert  the User Software CD into your computer.

2. Launch Fiery Downloader.

3. For Windows, browse to the Color\ Simulate fi le.

For Mac OS, browse to the Color:Simulat ion file.

4. For Windows, select  the Dic.ps file to load the DI C simulat ion; select  the Euroscl.ps fi le 

to load the Euroscale simulat ion; or select  the Swop.ps file to load the SWOP-Coated 

simulat ion.

For Mac OS, select  the Dic.ps file to load the DI C simulat ion; select  the Euroscale.ps 

file to load the Euroscale simulat ion; or select  the Swop.ps file to load the 

SWOP-Coated simulat ion.

5. Click Download to download the file to the Fiery XJ.

6. Reboot the Fiery XJ by powering it  off  and on.

The simulation target you just loaded remains the Fiery XJ default simulation until it 

is changed again.

7. I f  necessary, change the default  Rendering Style sett ing on the Fiery XJ.
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Print options give you access to the special features of the copier and the Fiery XJ. Print 

options can be specified in several places—in Fiery XJ Setup from the Control Panel, 

from the printing application, from Fiery Downloader, and from Fiery WebSpooler or 

Fiery Spooler. The table in this appendix briefly describes each print option, gives its 

default setting, and provides information on any constraints or requirements in effect. 

Where to set  print  opt ions

• During Fiery XJ Setup (from the Control Panel)

Some settings are specified during Setup by the administrator. To see the current 

default settings, print the Configuration page from the Fiery XJ Control Panel.

• From applications

With the Adobe PostScript printer drivers (included in your user software) and the 

Microsoft PostScript printer driver for Windows NT 4.0, you can specify and 

override job settings when you print a job. See Chapter 2, “Printing from Windows 

Computers” and Chapter 3, “Printing from Mac OS Computers” for information 

about specifying job settings from applications.

• From Fiery Downloader

Only one setting—Copies—can be specified when printing jobs with Fiery 

Downloader. To change the Copies setting in Fiery Downloader, select the job in the 

Files to be Downloaded (Windows) or Files to Download (Mac OS) list and click 

Options. For more information, see Chapter 5, “Downloading Files and Fonts”.

• Overrides from Fiery WebSpooler or Fiery Spooler

To change job settings from Fiery WebSpooler or Fiery Spooler, double-click a job to 

display the Override Print Settings dialog box. For more information, see Chapter 6, 

“Tracking and Managing Print Jobs.”

Appendix A: 

Print  Options
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Print  opt ions and override hierarchy

In the following table, underlined settings in the “Option and settings” column may 

indicate either default printer driver settings (PPD defaults), or that a default has been 

specified in Fiery XJ Setup. To find out about the current Setup defaults, print the 

Configuration page from the Fiery XJ Control Panel.

The override hierarchy is as follows: 

• A user’s printer driver settings override the Fiery XJ Setup settings.

• Settings made from Fiery WebSpooler or Fiery Spooler override the user’s printer 

driver settings. 

Option and sett ings:

( Default  sett ing is underlined)
Descript ion:

Requirements, constraints, 

and information:

Color Mode

Printer’s default / CMYK/ Grayscale

Specify the color mode for the current 

print job.

Select CMYK for a full-color document.

Select Grayscale for a grayscale or black-

and-white document.

The default setting for printing reflects 

the Color Mode setting specified in 

Fiery XJ PS Setup.

Copier Mode

Printer’s default / Photo/ Letter

Select Photo if the file is a photograph.

Select Letter if the file contains detailed 

drawings and small text.

Copies

1 -  999

Specify the number of copies of the job 

to print.

Media Type

Plain Paper/ Thick Paper/ Transparency

Select Plain Paper if you will be printing 

on standard bond copier paper.

Select Thick Paper if you will be printing 

on heavy paper stock.

Select Transparency if you will be 

printing on a transparency.

For more information, see page A-3.

Notes 1 and Notes 2 Use one or both of these fields to enter 

special information about the job.

The Notes 1 and Notes 2 fields each have 

a 32-character limit.

Page Order

Printer’s default / Forward/ Reverse

Select Forward to print the pages of your 

job from first to last.

Select Reverse to print the pages of your 

job from last to first.

The default setting for printing reflects 

the Page Order setting specified in 

Fiery XJ PS Setup.
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More information about print  opt ions

The following sections provide additional information about print options. See the 

table above for information on the settings, requirements, and constraints in effect for 

these options.

Media Type

The Media Type option allows you to select the type of media for loading into the 

bypass tray.

Plain Paper—Standard bond paper. Check your copier manual for specific 

information.

Thick Paper—Heavy paper. Check your copier manual for specific information.

Transparency—Transparency sheets.

Rendering Style

Use this option to select a default color rendering dictionary (CRD) to be used when 

you print RGB images, objects, and text.

Photographic—Optimizes the range of colors on the Fiery XJ to produce the best 

results for photographic or bitmapped images.

Presentat ion—Optimizes the output of pure, saturated colors such as those used in 

business presentations.

Solid Color—Most useful for printing spot colors such as those found in company 

logos or corporate charts and graphs.

Rendering Style

Printer’s default / Photographic/

Presentat ion/ Solid Color

Specify a default color rendering 

dictionary (CRD) to be used when you 

print RGB images, objects, and text.

The default setting for printing reflects 

the Rendering Style setting specified in 

Fiery XJ Color Setup.

For more information, see page A-3.

Sorter Mode

Printer’s default / Off / Collate/ Sort

Specify how to output multiple-page/

multiple-copy jobs.

For more information, see page A-4.

Option and sett ings:

( Default  sett ing is underlined)
Descript ion:

Requirements, constraints, 

and information:
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Sorter Mode

Off—Disables the sorter.

Collate—Copies of a complete job are collated and output into the bottom tray.

Sort—Copies of a complete job are sorted and output into one of 15 bins, arranged in 

page order.
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This appendix lists the built-in printer fonts included with your Fiery XJ.

Printer fonts

Listed below are the 136 built-in printer fonts on the Fiery XJ.

In addition to the fonts listed below, two Adobe Multiple Master fonts are included 

and are used for font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the User 

Software CD. For instructions, see Getting Started.

Adobe Type 1 fonts

The Fiery XJ includes 117 Adobe Type 1 fonts:

• The Mac OS column lists the name as it appears on the Font menu on a Mac OS 

computer. For example, in most applications, to use “Bodoni-Bold,” choose Bodoni 

Bold from the Font menu.

• The Windows menu name is the name as it appears on the Font menu on a 

Windows computer. The style refers to the style that must be selected in the 

application to access the particular PostScript font. For example, to use “Bodoni-

Bold,” choose Bodoni from the Font menu and Bold from the Style menu.

PostScript  name: Mac OS menu name: Windows menu name, style: 

AlbertusMT-Light Albertus MT Lt Albertus MT Lt 

AlbertusMT Albertus MT Albertus MT 

AlbertusMT-Italic Albertus MT It Albertus MT, Italic 

AntiqueOlive-Roman Antique Olive Roman Antique Olive Roman

AntiqueOlive-Bold Antique Olive Bold Antique Olive Roman, Bold

AntiqueOlive-Italic Antique Olive Italic Antique Olive Roman, Italic

AntiqueOlive-Compact Antique Olive Compact Antique Olive Compact

AvantGarde-Book Avant Garde AvantGarde

AvantGarde-Demi Avant Garde Demi AvantGarde, Bold

AvantGarde-BookOblique Avant Garde BookOblique AvantGarde, Italic

Appendix B: 

Font List
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AvantGarde-DemiOblique Avant Garde DemiOblique AvantGarde, Bold Italic

Bodoni Bodoni Bodoni

Bodoni-Bold Bodoni Bold Bodoni, Bold

Bodoni-Italic Bodoni Italic Bodoni, Italic

Bodoni-BoldItalic Bodoni BoldItalic Bodoni, Bold Italic

Bodoni-Poster Bodoni Poster Bodoni Poster

Bodoni-PosterCompressed Bodoni PosterCompressed Bodoni PosterCompressed 

Bookman-Light Bookman Bookman 

Bookman-Demi Bookman Demi Bookman, Bold 

Bookman-LightItalic Bookman LightItalic Bookman, Italic 

Bookman-DemiItalic Bookman DemiItalic Bookman, Bold Italic

Carta Carta Carta

Clarendon-Light Clarendon Light Clarendon Light 

Clarendon Clarendon Clarendon 

Clarendon-Bold Clarendon Bold Clarendon, Bold

CooperBlack Cooper Black Cooper Black 

CooperBlack-Italic Cooper Black Italic Cooper Black, Italic

Copperplate-ThirtyThreeBC Copperplate33bc Copperplate33bc

Copperplate-ThirtyTwoBC Copperplate32bc Copperplate32bc

Coronet Coronet Coronet

Courier Courier Courier 

Courier-Bold Courier Bold Courier, Bold 

Courier-Oblique Courier Oblique Courier, Italic 

Courier-BoldOblique Courier BoldOblique Courier, Bold Italic

Eurostile Eurostile Eurostile

Eurostile-Bold Eurostile Bold Eurostile Bold

Eurostile-ExtendedTwo Eurostile ExtendedTwo Eurostile ExtendedTwo

Eurostile-BoldExtendedTwo Eurostile BoldExtendedTwo Eurostile ExtendedTwo, Bold

GillSans GillSans GillSans 

GillSans-Bold GillSans Bold GillSans, Bold 

GillSans-Italic GillSans Italic GillSans, Italic 

GillSans-BoldItalic GillSans BoldItalic GillSans, Bold Italic 

GillSans-Light GillSans Light GillSans Light 

GillSans-LightItalic GillSans LightItalic GillSans Light, Italic

PostScript  name: Mac OS menu name: Windows menu name, style: 
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GillSans-Condensed GillSans Condensed GillSans Condensed 

GillSans-BoldCondensed GillSans BoldCondensed GillSans Condensed, Bold 

GillSans-ExtraBold GillSans ExtraBold GillSans ExtraBold 

Goudy Goudy Goudy 

Goudy-Bold Goudy Bold Goudy, Bold 

Goudy-Italic Goudy Italic Goudy, Italic 

Goudy-BoldItalic Goudy BoldItalic Goudy, Bold Italic

Goudy-ExtraBold Goudy ExtraBold Goudy ExtraBold

Helvetica Helvetica Helvetica 

Helvetica-Bold Helvetica Bold Helvetica, Bold 

Helvetica-Oblique Helvetica Oblique Helvetica, Italic 

Helvetica-BoldOblique Helvetica BoldOblique Helvetica, Bold Italic

Helvetica-Narrow Helvetica Narrow Helvetica-Narrow 

Helvetica-Narrow-Bold Helvetica Narrow Bold Helvetica-Narrow, Bold 

Helvetica-Narrow-Oblique Helvetica Narrow Oblique Helvetica-Narrow, Italic 

Helvetica-Narrow-BoldOblique Helvetica Narrow BoldObl Helvetica-Narrow, Bold Italic

Helvetica-Condensed Helvetica Condensed Helvetica Condensed 

Helvetica-Condensed-Bold Helvetica CondensedBold Helvetica Condensed, Bold 

Helvetica-Condensed-Oblique Helvetica CondensedOblique Helvetica Condensed, Italic 

Helvetica-Condensed-BoldObl Helvetica CondensedBoldObl Helvetica Condensed, Bold Italic

JoannaMT Joanna MT Joanna MT 

JoannaMT-Bold Joanna MT Bd Joanna MT, Bold 

JoannaMT-Italic Joanna MT It Joanna MT, Italic

JoannaMT-BoldItalic Joanna MT Bd It Joanna MT, Bold Italic

LetterGothic Letter Gothic Letter Gothic 

LetterGothic-Bold Letter Gothic Bold Letter Gothic, Bold 

LetterGothic-Slanted Letter Gothic Slanted Letter Gothic, Italic 

LetterGothic-BoldSlanted Letter Gothic BoldSlanted Letter Gothic, Bold Italic

LubalinGraph-Book Lubalin Graph LubalinGraph 

LubalinGraph-Demi Lubalin Graph Demi LubalinGraph, Bold 

LubalinGraph-BookOblique Lubalin Graph BookOblique LubalinGraph, Italic 

LubalinGraph-DemiOblique Lubalin Graph DemiOblique LubalinGraph, Bold Italic 

Marigold Marigold Marigold

MonaLisa-Recut Mona Lisa Recut Mona Lisa Recut

PostScript  name: Mac OS menu name: Windows menu name, style: 
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NewCenturySchlbk-Roman New Century Schlbk NewCenturySchlbk 

NewCenturySchlbk-Bold New Century Schlbk Bold NewCenturySchlbk, Bold 

NewCenturySchlbk-Italic New Century Schlbk Italic NewCenturySchlbk, Italic 

NewCenturySchlbk-BoldItalic New Century Schlbk BoldIt NewCenturySchlbk, Bold Italic

Optima Optima Optima 

Optima-Bold Optima Bold Optima, Bold 

Optima-Italic Optima Italic Optima, Italic 

Optima-BoldItalic Optima BoldItalic Optima, Bold Italic

Oxford Oxford Oxford

Palatino-Roman Palatino Palatino 

Palatino-Bold Palatino Bold Palatino, Bold 

Palatino-Italic Palatino Italic Palatino, Italic 

Palatino-BoldItalic Palatino BoldItalic Palatino, Bold Italic

StempelGaramond-Roman StempelGaramond Roman StempelGaramond Roman 

StempelGaramond-Bold StempelGaramond Bold StempelGaramond Roman, Bold 

StempelGaramond-Italic StempelGaramond Italic StempelGaramond Roman, Italic 

StempelGaramond-BoldItalic StempelGaramond BoldItalic StempelGaramond Roman, Bold 

Italic

Symbol Symbol Symbol

Tekton Tekton Tekton

Times-Roman Times Times

Times-Bold Times Bold Times, Bold

Times-Italic Times Italic Times, Italic

Times-BoldItalic Times BoldItalic Times, Bold Italic

Univers-Extended Univers Extended Univers Extended 

Univers-BoldExt Univers BoldExt Univers Extended, Bold 

Univers-ExtendedObl Univers ExtendedObl Univers Extended, Italic 

Univers-BoldExtObl Univers BoldExtObl Univers Extended, Bold Italic 

Univers-Light Univers 45 Light Univers 45 Light 

Univers-Bold Univers 65 Bold Univers 45 Light, Bold 

Univers-LightOblique Univers 45 LightOblique Univers 45 Light, Italic 

Univers-BoldOblique Univers 65 BoldOblique Univers 45 Light, Bold Italic 

Univers Univers 55 Univers 55 

Univers-Oblique Univers 55 Oblique Univers 55, Italic 

PostScript  name: Mac OS menu name: Windows menu name, style: 



B
B-5 Font List

TrueType fonts

The Fiery XJ includes 19 TrueType fonts:

Univers-CondensedBold Univers 67 CondensedBold Univers 47 CondensedLight, 

Bold 

Univers-CondensedBoldOblique Univers 67 CondensedBoldObl Univers 47 CondensedLight, 

Bold Italic 

Univers-Condensed Univers 57 Condensed Univers 57 Condensed 

Univers-CondensedOblique Univers 57 CondensedOblique Univers 57 Condensed, Italic

ZapfChancery-MediumItalic Zapf Chancery ZapfChancery

ZapfDingbats Zapf Dingbats ZapfDingbats

PostScript  name: Mac OS menu name: Windows menu name, style:

Apple-Chancery Apple Chancery Apple Chancery

Arial-BoldItalicMT Arial Bold Italic Arial, Bold Italic

Arial-BoldMT Arial Bold Arial, Bold

Arial-ItalicMT Arial Italic Arial, Italic

ArialMT Arial Arial

Chicago Chicago Chicago

Geneva Geneva Geneva

HoeflerText-Black Hoefler Text Black Hoefler Text Black

HoeflerText-BlackItalic Hoefler Text Black Hoefler Text Black, Italic

HoeflerText-Italic Hoefler Text Hoefler Text, Italic

HoeflerText-Ornaments Hoefler Text Ornaments Hoefler Text Ornaments

HoeflerText-Regular Hoefler Text Hoefler Text

Monaco Monaco Monaco

New York New York New York

TimesNewRomanPS-BoldMT Times New Roman Bold Times New Roman, Bold

TimesNewRomanPS-

BoldItalicMT

Times New Roman Bold Italic Times New Roman, Bold Italic

TimesNewRomanPS-ItalicMT Times New Roman Italic Times New Roman, Italic

TimesNewRomanPSMT Times New Roman Times New Roman

Wingdings-Regular Wingdings Wingdings

PostScript  name: Mac OS menu name: Windows menu name, style: 
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This appendix provides a list of error messages that may appear on the Fiery XJ 

Control Panel, as well as troubleshooting tips.

Error messages

Error messages can result from problems with the print job, the Fiery XJ, or the copier. 

Some of the most common error conditions are listed here.

Following are the messages (listed in alphabetical order), with the appropriate 

corrective action for each one. You can cancel the pending print job while you attend 

to the error condition. A few normal status messages are included in this list in case 

they cause concern.

Fiery XJ message: Correct ive act ion/ addit ional information:

Busy The Fiery XJ has received a print job, but the copier is being used 

to make a copy. This message appears when someone makes a copy 

without first selecting Suspend Printing  from the Functions menu. 

The Fiery XJ will begin the print job when the copy job is finished.

Check po wer & cable There is a problem with the copier power or cable connection. 

First check to make sure that the copier is turned on. There may 

also be a problem with the cable connection between the Fiery XJ 

and the copier. Make sure that the cable has not come loose. The 

Fiery XJ will resume printing when the cable is securely connected 

to both the Fiery XJ and the copier.

Clo se Bypass Tray The bypass tray is open. The Fiery XJ will resume printing when 

the bypass tray is closed.

Co mmunicatio n erro r There is a communication error between the copier and the 

Fiery XJ. Check the cable connections and the copier’s user 

interface for additional information.

Co pier o ffline Someone has selected Suspend Printing  from the Functions menu 

on the Fiery XJ Control Panel. When you select Resume Printing  

on the Control Panel, printing will resume normally.

Do o r o pen One of the copier doors is open. The Fiery XJ will resume printing 

when the door is closed.

Appendix C: 
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Erro r-check panel There is an unidentified problem with the copier. Check the copier 

user interface for additional messages. The copier will resume 

printing when the problem is corrected.

Lo ad _ _ _

in any tray

The copier is not loaded with the paper size specified. The Fiery XJ 

will resume printing when the copier is loaded with the required 

paper.

Lo ad _ _ _

in bypass tray

The copier’s bypass tray is not loaded with the paper size specified. 

The Fiery XJ will resume printing when the bypass tray is loaded 

with the required paper.

Lo ad _ _ _

thick in bypass tray

The bypass tray is not loaded with the thick paper specified. The 

Fiery XJ will resume printing when you have loaded the required 

thick paper into the bypass tray.

Lo ad _ _ _

trans in bypass tray

The bypass tray is not loaded with the transparencies specified. The 

Fiery XJ will resume printing when you have loaded the required 

transparencies into the bypass tray.

Lo ad _ _ _

tray 1

The copier’s Tray 1 is not loaded with the paper size or type 

specified. The Fiery XJ will resume printing when Tray 1 is loaded 

with the required paper.

Lo ad _ _ _

tray 2

The copier’s Tray 2 is not loaded with the paper size or type 

specified. The Fiery XJ will resume printing when Tray 2 is loaded 

with the required paper.

Lo ad _ _ _

tray 3

The copier’s Tray 3 is not loaded with the paper size or type 

specified. The Fiery XJ will resume printing when Tray 3 is loaded 

with the required paper.

No  black to ner The black (K) toner has run out. Replenish the black toner 

container according to the instructions in your copier manual.

No  cyan to ner The cyan (C) toner has run out. Replenish the cyan toner 

container according to the instructions in your copier manual.

No  fuser o il The fuser oil bottle in the fixing assembly is empty. Replace the 

fuser oil according to the instructions in your copier manual. The 

Fiery XJ will resume printing when you have replaced the fuser oil.

No  magenta to ner The magenta (M) toner has run out. Replenish the magenta toner 

container according to the instructions in your copier manual.

Fiery XJ message: Correct ive act ion/ addit ional information:
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Maintaining optimal system performance

The Fiery XJ does not require maintenance. Beyond the routine requirements of 

servicing and maintaining the copier and replenishing consumables there are a few 

things you can do to improve the overall performance of your system:

• Reduce unnecessary two-way communication.

If users notice that the server is frequently too busy to receive jobs, it may be because 

several users are running utilities that are updated often. Large numbers of remote 

users running Fiery Downloader or Fiery WebTools may have a significant effect on 

Fiery XJ performance.

• Schedule the printing workload by checking job ticket information before printing. 

Print jobs with the same output and paper specifications together to minimize paper 

changes. Also, print routine jobs while you prepare to print jobs with special 

instructions or special media.

No  yello w to ner The yellow (Y) toner has run out. Replenish the yellow toner 

container according to the instructions in your copier manual.

Paper jam There is a paper jam in the copier. Open the copier doors and 

check the locations indicated on the copier display. The Fiery XJ 

will resume printing when you have cleared the paper jam and 

closed the copier doors.

So rter limit _ _ _ The sorter unit has one bottom output tray and 15 output bins; 

therefore, the maximum number of copies that can be sorted is 15. 

Sending 16 or more copies to the sorter results in the excess copies 

of the job being discarded. In order to print and sort more than 15 

copies you can resend the job, 15 copies at a time, from the Print 

dialog box, from Fiery WebSpooler, or from Fiery Spooler.

Unkno wn erro r An error occurred with the copier. Check the copier user interface 

for more information.

Warming up The copier is powering up. It will be ready for printing in a few 

minutes.

Waste to ner full The copier’s waste toner container is full. The Fiery XJ will resume 

printing when you empty or replace the container. 

Fiery XJ message: Correct ive act ion/ addit ional information:
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• Avoid printing with the server “Disk full” warning. 

If you see this warning, delete jobs that have been held for a long time and are not 

likely to be needed. Avoid this condition by deleting old jobs on a regular basis. The 

date associated with a job is the original date it was sent.

Even when the disk is full, some disk space is reserved for printing a tabloid size job, 

but printing proceeds only when the oldest printed job is deleted from the Printed 

queue (Print area).

Troubleshooting

In case of problems, and before you call for service, check the guidelines in this section. 

If you are unable to resolve the problem, make a note of the error condition and 

contact your authorized service/support center.

This section provides some troubleshooting guidelines should a problem arise. If you 

are unable to resolve a problem after referring to this section, contact your site 

administrator. 

General print ing problems

I f  this happens: Try this:

You cannot select or view one 

of the queues.

• Have your system administrator enable the queue in Setup on the Fiery XJ Control 

Panel.

Printing ties up your 

computer for too long.

• Print  to the Print  queue instead of  to the Direct  connection.

When you print to the Print queue, the job is stored on the Fiery XJ until it can be 

processed and printed; when you print to the Direct connection, the job cannot be sent 

to the Fiery XJ until the previous job is finished processing, so you must wait longer to 

use your computer.

Special paper or transparency 

options are dimmed.

• Select  a Paper Source that  supports the media type you are using.
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Message requests a paper size 

that you don’t have.

• Cancel the job and do one of  the following:

If you are printing a PostScript file, ask the administrator to set the Convert Paper Sizes 

setting in PS Setup to convert the job to a paper size you do have. You can do this to 

convert between US and metric paper sizes.

If you are printing a file from an application, change the page size in the Page Setup 

dialog box.

You cannot print with 

QuarkXPress 3.32 using the 

AdobePS 8.5.1 driver on a 

Mac OS computer.

• Remove the file called Balloon Help from your QuarkXPress applicat ion folder and 

relaunch QuarkXPress.

Fiery XJ doesn’t respond to a 

Print command.

• Has someone disconnected the copier by select ing Suspend Print ing from the Functions 

menu?

If someone has selected Suspend Printing  on the Fiery XJ Control Panel to interrupt 

printing (to make a color copy, for example), your print job will not resume until 

someone selects Resume Printing  from the Functions menu on the Control Panel.

• Did you select  the Fiery XJ as the current  printer?

Before printing, you must select the Fiery XJ as the current printer from your Mac OS, 

Windows, or UNIX workstation.

• Make sure that  the copier is switched on.

Someone may have turned the copier off, or the Automatic Power-Off or Power Saver 

mode function may have engaged. Even with the copier off, the Fiery XJ appears in the 

Chooser as long as the Fiery XJ itself is turned on. 

• I f  you are print ing over an I PX ( Novell)  network, verify through the PCONSOLE ut i li ty 

that  the job was sent to the Novell queue and that  the queue is being used by the 

Fiery XJ.

• Make sure that  the job does not contain a PostScript  error.

Use Fiery WebSpooler (or Fiery Spooler) to check the job’s status. A job containing a 

PostScript error appears in red in the Fiery WebSpooler display.

I f  this happens: Try this:
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Problems with print  quality

Jobs sent to the parallel port 

do not print.

• Review the procedures provided in Get t ing Start ed on how to prepare the Fiery XJ and 

your Windows 95 computer for parallel port  print ing.

Also see your Windows 95 documentation.

• Ask the administrator to increase the parallel “Port  Timeout in Seconds” on the Fiery XJ 

Control Panel.

• Ask the administrator to change the I gnore EOF Character sett ing on the Fiery XJ 

Control Panel.

If you will be printing ASCII format PostScript only, set Igno re EOF Character to No ; if 

you will be printing Binary format PostScript, set it to Yes.

• I f  you print  using the DOS copy command, make sure to use the / b  opt ion when 

print ing binary fi les.

• I f  the PostScript  printer driver that  you are using lets you select  bidirect ional 

communicat ion, make sure that  i t  is disabled. 

This is generally set from the Properties dialog box for the printer. 

I f  this happens: Try this:

Print settings for your job 

output do not match the 

settings you gave.

• Make sure that  you did not override the sett ing for the job in another place.

For information about options and overrides, see Appendix A "Print Options."

You get poor printing results. • Does your applicat ion require one of  Fiery XJ printer descript ion files?

If you are printing from an application such as Adobe Separator or PageMaker, 

MacroMedia FreeHand, or QuarkXPress, make sure that the Fiery XJ printer 

description file is installed correctly. For information about installing these files, see 

Getting Started.

• Make sure the system has been calibrated.

The registration or colors of 

an image are not what you 

expected.

• Print  a test  page or make a test  copy with the copier.

The problem may be with the copier. If your test page or copy show that the copier is 

working properly, correct the problem within your application software. If the test page 

or copy are wrong, your copier may need to be calibrated or adjusted in some other 

way. 

I f  this happens: Try this:
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Problems with Fiery Downloader

Color output is incorrect. • Check with the administrator about the current  calibrat ion information. 

The copier may need to be recalibrated because it has been too long since it was 

calibrated or because it is using a different target.

• Check with the administrator about the current  simulat ion target  loaded on the 

Fiery XJ. 

For more information, see “Working with simulations” on page C-7.

Color file prints in black and 

white.

• I n the Print  Options dialog box, make sure that  Color/ Grayscale or ColorSync Color 

Matching or PostScript  Color Matching is selected ( not  Black and White) .

• Make sure that  the Color Mode selected for the job is CMYK and not Grayscale.

Desktop Color Separations 

(DCS) format images print 

incorrectly.

• Make sure that  you selected the correct  opt ions to send separat ions in the applicat ion’s 

Print  dialog box.

• Make sure that  you have the fi le for every layer of  separat ion that  you are print ing.

QuickDraw fill patterns print 

as solids.

• Use the Adobe PostScript  Printer driver ( or the Apple LaserWriter 8.3 or later printer 

driver) .

I f  this happens: Try this:

General problems • Make sure that  you are using the latest  version.

If you are updating your Fiery XJ to new system software, delete the previous versions 

of Fiery Downloader from your Mac OS or Windows computer and install the latest 

versions to insure full compatibility.

• Make sure eit her the NET_WI PX.DLL file ( for I PX/ SPX networks)  or the NET_WSCK.DLL 

file ( for TCP/ I P networks)  is in the WI NDOWS\ SYSTEM directory.

Only one of these files should be in the WINDOWS\SYSTEM directory and it must be 

the correct file for your system.

• Make sure that  the NET_WSCK.I NI  fi le is in the WI NDOWS directory.

• Open the NET_WSCK.I NI  fi le in a text  editor and make sure that  i t  is customized 

correct ly for your site; or, throw away the NET_WSCK.I NI  fi le and configure the Chooser 

list  again.

For more information, see Getting Started.

I f  this happens: Try this:
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You cannot connect to the 

Fiery XJ from Fiery 

Downloader.

• Make sure that  the Fiery XJ is not  being calibrated.

If the Fiery XJ is being calibrated, you cannot connect to it. This insures that only one 

person is calibrating the server at any time and that print jobs do not use unexpected 

calibration.

• I f  you are using Windows 95 or Windows NT, verify that  the .DLL file in your 

Windows\ System folder is the correct  one for the network protocol you are using. 

For IPX networks, the correct file is NET_WIPX.DLL. For TCP/IP networks, the 

correct file is NET_WSCK.DLL. Only one of these files should be in the 

Windows\System folder.

• Make sure your NET_WSCK.I NI  fi le is set  up correct ly.

This file must be set up for Windows 95 and Windows NT printing with TCP/IP and 

IPX/SPX. For instructions, see Getting Started.

You cannot print an EPS file 

using Fiery Downloader.

• Try print ing using the “Showpage” option in the Download PostScript  File dialog box.

The Showpage (after EPS files) option adds a showpage PostScript language command 

at the end of the print job. Certain applications omit this necessary PostScript language 

command when they generate EPS files. You will need to select the Append Showpage 

option when printing EPS files generated by these applications.

If you continue having difficulties printing an EPS file with Fiery Downloader, try 

printing the file from the application in which it was created.

• Make sure that  the job does not contain a PostScript  error.

Use Fiery WebSpooler to check the job’s status. A job containing a PostScript error 

appears in red in the Fiery WebSpooler display.

You have problems 

downloading a font with 

Fiery Downloader.

• Check with the administrator to make sure that  the Direct  connection is enabled.

The Direct connection must be used to download fonts. (Files can be downloaded via 

the Print queue.)

Extra blank page prints after a 

Fiery Downloader job.

• Turn off  the “Showpage ( after EPS file) ” opt ion.

This option adds a special PostScript command that will cause an extra blank page to 

print if it is not needed.

I f  this happens: Try this:
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Problems with Fiery WebTools

Setup error messages

For information on Setup error messages, see the Administrator Guide.

AutoCal error messages

AutoCal error messages can result from problems during the AutoCal procedure.

I f  this happens: Try this:

General problems • Clear the cache ( Netscape Communicator)  or history ( Microsoft  I nternet  Explorer) .

Fiery XJ message: Addit ional information:

Erro r 5 The calibration file cannot be opened.

Erro r 6 The calibration file was not read correctly.

Erro r 8 The measurement page did not scan properly, either because it is 

crooked or the data is corrupted.

Erro r 11 The color strips on the measurement page are inconsistent.

Erro r 12 The copier model being used is not supported.

Erro r 20 The measurement page cannot be scanned because the dots per 

inch (dpi) are incorrect.

Erro r 102 The grayscale strip is crooked or is positioned incorrectly.

Erro r 103 The grayscale strip is positioned too far to the left or to the right of 

the measurement page.

Erro r 104 The grayscale strip is positioned too far above the measurement 

page.

Erro r 111 The grayscale strip could not be found; either reposition the strip 

correctly or position it vertically.
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A
access

levels xv, 6-2

restricting xv, 6-4

Administrator password xv, 1-5, 6-3, 6-4

Alert Status screen 1-2

AppleTalk 3-2

AutoCal calibration 7-5, 7-6

B
Brightness option 5-5

broken LCD 1-7

buttons, Control Panel 1-2

C
calibration

checking status 7-5

current 7-1

from the Control Panel 7-1, 7-5, 7-6

measurements 7-1, 7-2, 7-3

overview 7-1, 7-2

resident 7-1

scheduling 7-3

self-calibration 7-4

targets 7-1, 7-2

Calibration option 1-6

calibration patch page 7-3

cancel command (UNIX) 4-3

Cancel Job

from the Control Panel during 

printing 1-3

from the Control Panel during 

RIPping 1-3

Change (Administrator) Password 

option 1-6

Chooser list (Windows) C-7

Clear Server command 1-6

color, troubleshooting output C-7

Color Mode option A-2

Color Setup option 1-6

Comparison Page

calibration 7-3

Configuration page 7-5

printing from the Control Panel 1-4

Configure button

Fiery WebTools 6-4

Confirm file deletion option 6-23

Control Panel 1-1 to 1-7

activity light 1-1, 1-3

buttons 1-2

calibration from 7-1

down button 1-2

Functions menu 1-4

line selection buttons 1-2

Menu button 1-2

removing calibration 7-7

status screens 1-2

up button 1-2

Control Panel, printer settings 

overridden 2-7

Control Panel map

printing from the Control Panel 1-4

copier, adjusting printed color from 7-4

Copier Mode option A-2

Copies option A-2

D
DCS (Desktop Color Separations) files

default settings, see printer default settings

Delete command 6-11, 6-14

Delete Job Log command 6-10

densitometer

for calibration 7-5

density patches 7-4

Desktop Color Separations, see DCS

DIC simulation 7-7
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differences

between Fiery Spooler for Windows and 

Fiery WebSpooler 6-18

Direct connection xvi, 5-5, 6-12

not in Chooser, Mac OS 3-1

required to download fonts 5-6, C-8

disk space used 6-8

display window 1-2

documentation xii

down button 1-2

Downloader, see Fiery Downloader

Duplicate command 6-11

E
EPS (Encapsulated PostScript) files

downloading from Mac OS 3-4

downloading from Windows 2-8

EPS files C-8

downloading 2-1

error messages during Setup C-9

Euroscale simulation 7-7

Exit command 6-10

Exit Setup option 1-6

F
Fiery Downloader 5-1 to 5-8

choosing a printer 5-3

Connection Type option 5-5

Copies option 5-5

downloading files or fonts 5-3 to 5-6

Download Progress bar 5-2

Font List option 5-3

Hard Disk area 5-2

Mac OS 3-4

printing from 5-3

Print Status area 5-2

restriction with parallel port 2-8

RIP Status area 5-2

troubleshooting C-7 to C-8

using from remote workstation 5-1

Windows 2-8

Fiery Spooler

changing print settings 6-25

deleting jobs 6-25

duplicating jobs 6-24

overriding user job settings A-1

Fiery Spooler, overriding Printer Setup 2-4, 

2-7

Fiery WebSpooler

accessing 6-6

Guest (view-only) privileges 6-8

Job menu 6-14

overview 6-2

status bars 6-8

Fiery WebTools

accessing xvi, 6-3, 6-5

Configure button 6-4

home page 6-4

Installer 6-2

passwords 6-2

problems with C-9

Status 6-2, 6-4, 6-5

WebSpooler 2-4, 2-7, 6-2, A-1

File menu commands 6-10

File port, saving files to 2-8

font list

displaying 5-2

printing 5-2

Font List option (Fiery Downloader) 5-3

fonts

Adobe Type 1 5-6, 5-7, B-1

downloading and managing 5-1, 5-5, 5-

6, 5-7

list, displaying 5-8

locked 5-8

PostScript B-1

printer fonts 5-7

printer fonts on server 1-4

printing font list 1-4

screen fonts (Mac OS) 5-7

TrueType 5-6, B-5
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Font Substitution Table 5-6

Functions menu, Control Panel 1-3, 1-4

G
Guest access xv, 6-3, 6-7

H
held jobs 6-13

Help menu commands 6-11

I
icons

Print area 6-13

RIP area 6-13

Spool area 6-12

Info Status screen 1-3

Installer WebTool, see Fiery WebTools

J
job

areas 6-9

defined xiii

deleting 6-14

deleting in Fiery Spooler 6-25

duplicating 6-24

limit 6-13

overrides 6-15

job icons 6-10

Print area 6-13

RIP area 6-13

Spool area 6-12

Job Log

displaying 6-16

printing from the Control Panel 1-4

using (from Fiery Spooler) 6-26

using (from Fiery WebSpooler) 6-16

viewing printed jobs 6-10

Job Log Setup option 1-6

Job menu commands 6-11, 6-14

job overrides

Color Mode option A-2

Copier Mode option A-2

Media Type option A-3

Page Order option A-2

Rendering Style option A-3

Sorter Mode option A-3, A-4

job settings, see print options

Jobs Saved in Printed Queue 6-13

L
LCD 1-1, 1-7

line selection buttons 1-2

lock icon 5-8

lp command 4-2

lpq command 4-1, 4-2, 4-3

lpr command 4-1

lprm command 4-1, 4-3

M
Mac OS

Paper Source menu 3-3

PostScript printer setup 3-2

printer default settings 3-3

Printer Specific Options menu 3-3

printing 3-1 to 3-4

printing with Fiery Downloader 5-1 to 

5-8

tray selection 3-3

measurements file 7-2, 7-3

Media Type option A-2, A-3

Menu button 1-2

messages, see error messages

N
NET_WIPX.DLL C-7, C-8

Network Setup option 1-6

NET_WSCK.DLL C-7, C-8

NET_WSCK.INI C-7, C-8

Notes fields A-2

in Job Log 6-27

Mac OS 3-3

Windows 95 2-5
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O
on/off switch 1-5

Override Print Settings command 6-11, 6-

15, 6-25

P
Page Order option A-2

paper, sizes supported xiv

Paper Source menu

Mac OS 3-3

Windows 95 2-3

Windows NT 4.0 2-7

parallel port

printing problems C-6

printing with 2-8

passwords

Administrator 6-3

Change (Administrator) Password 

option 1-6

for calibration 7-1

performance, optimizing C-3

permissions xv

Photographic rendering style option A-3

Plain Paper option A-3

PostScript xiii, 6-9

downloading files from Mac OS 3-4

downloading files from Windows 2-8

downloading files with Fiery 

Downloader 5-1

error 6-13

icon 6-12

printing files from UNIX 4-1

RIP xiii

PostScript printer description files, see PPD 

files

PostScript printer drivers xiv

Mac OS 3-1

Windows 95 2-1

PostScript printer setup

Mac OS 3-2

PostScript Setup option, see PS Setup option

power switch 1-5

PPD (PostScript Printer Description) 

files xiii, xiv

defaults A-2

PPDs 2-1, 3-1

Presentation rendering style option A-3

press simulations, see simulations

Print area 6-9

icons 6-13

Print command 6-11, 6-14

Print command (Windows) 2-1

Printed queue 6-10, 6-13, 6-19

printer (job) icon 6-12

printer default settings xvi, A-1 to A-4

Mac OS 3-3

Windows 95 2-4

printer driver, see PostScript printer drivers

printer settings, customizing 6-11

printer setup

settings 2-7

with Adobe PostScript Printer Driver for 

Windows 95 2-2 to 2-5

with Microsoft PostScript Printer Driver 

for Windows NT 4.0 2-6

Printer Setup option 1-6

Printer Specific Options menu 3-3

printing

Configuration page 1-4

defined xiii

font list 1-4, 5-2

from Fiery Downloader 5-1 to 5-8

from Mac OS applications 3-1 to 3-4

server information pages 1-4

to local port 2-8

troubleshooting C-4 to C-8

UNIX workstations 4-1 to 4-3

Windows 95 2-1

Windows NT 4.0 2-6

with parallel port 2-8

printing connections on the network xvi

Print Job Log command 6-10
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print jobs

deleting from queue 6-11

print options A-1 to A-4

settings 2-5

specific to color server 2-4, 2-7

Windows 95 2-2 to 2-5

see also printer default settings

Print Pages command 1-4

Control Panel 1-4

Print queue xvi, 5-5, 6-19

not in Chooser, Mac OS 3-1

Print Status screen 1-3

Process Next command 6-11, 6-14

PS Setup option 1-6

Q
QuarkXPress, printing problems C-5

queues 6-9

queues, access to xvi

Queues window

spooled jobs 6-9

R
RAM

in use 6-8

total 6-8

raster

data 6-13, 6-14

icon 6-12

rasterizing, see RIPping

Reboot Server command, from Control 

Panel 1-4

remote access 5-1

Rename command 6-11, 6-14

Rendering Style option A-3

resident calibration 7-1

resolutions supported xiv

restricting access to server xv

Resume Printing command

Control Panel 1-4

RIP, defined xiii

RIP area 6-9, 6-13

RIPped jobs 6-9

RIPping

RIP Status screen 1-3

Run Diagnostics command 1-4

S
safety 1-7

server

cleaning 1-7

display window 1-7

restarting 1-6

shutting down 1-7

Server Setup option 1-6

‘showpage’ after EPS files option 5-5

simulations

overview 7-7

Solaris 2 4-3

Solid Color rendering style option A-3

Sorter Mode option A-3, A-4

spool, defined xiii

Spool area 6-9

job icons 6-12

spooled jobs 6-9

displayed in Fiery WebSpooler 6-10

icons 6-12

Spooler, see Fiery Spooler

starting the server 1-5

status bars 6-8, 6-11

Print 6-8

RIP 6-8

Spool 6-8

status screens, Control Panel 1-2

Status WebTool, see Fiery WebTools

SunOS 4 4-3

Suspend Printing command

from Control Panel 1-4

SWOP-Coated simulation 7-7
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T
target curve, see targets

targets 7-2

copier target 7-3

Linear 7-3

provided with the color server 7-3

see also calibration and simulations

TCP/IP printing 4-1

Test Page 7-5

printing from Control Panel 1-4

Thick Paper option A-3

transfer functions 7-2

Transparency option A-3

tray selection

Mac OS 3-3

Windows 95 2-3

Windows NT 4.0 2-7

troubleshooting C-4

color output C-7

Fiery Downloader C-7 to C-8

general printing problems C-4 to C-6

problems with print quality C-6 to C-7

U
UNIX

BSD (Berkeley Software Distribution) 

variant of 4-3

displaying jobs in queue with 4-2

printing from 4-1 to 4-3

removing jobs from queue with 4-3

System V 4-3

up button 1-2

user software xvi

W
warning

display window breakage 1-7

WebSpooler

overriding user job settings A-1

WebSpooler, see Fiery WebTools

Windows 95

Notes fields 2-5

Paper Source menu 2-3

PostScript printer driver 2-1

printer default settings 2-4

printing with 2-1

tray selection 2-3

Windows NT 4.0

Paper Source menu 2-7

printing with 2-6

tray selection 2-7


	Preface
	Copier support and media pack
	About the documentation
	About this manual
	Terminology and conventions

	How the Fiery�XJ works
	About PostScript printer drivers and PPDs

	Supported paper sizes
	Fiery�XJ job environments
	Permissions

	Before you begin

	Chapter 1: Using the Control Panel
	Introduction to the Fiery�XJ Control Panel
	Activity light
	Buttons
	Display window
	Functions menu

	Starting and shutting down the Fiery�XJ
	Starting the Fiery�XJ
	Restarting the Fiery�XJ
	Shutting down the Fiery�XJ

	Safety warnings
	Cleaning the Fiery�XJ

	Chapter 2: Printing from Windows Computers
	Printing from applications
	Setting options and printing from Windows 95
	Setting options and printing from Windows NT 4.0
	Printing to the parallel port
	Saving files to print at a remote location

	Using Fiery Downloader to print

	Chapter 3: Printing from Mac OS Computers
	Printing from applications
	Selecting the Fiery�XJ in the Chooser
	Setting print options and printing from Mac OS computers

	Using Fiery Downloader to print

	Chapter 4: Printing from UNIX Workstations
	Printing to the Fiery�XJ

	Chapter 5: Downloading Files and Fonts
	Using Fiery Downloader
	Printing with Fiery Downloader
	Downloading and managing printer fonts


	Chapter 6: Tracking and Managing Print Jobs
	Tools for job tracking and management
	Fiery�WebTools
	Fiery Spooler

	About Fiery�WebTools
	Access privileges
	Checking Fiery�XJ status with the Status WebTool

	Fiery�WebSpooler and Fiery Spooler for Windows
	Job management features
	Job List window
	Job icons
	Job commands
	Overriding print settings
	Using the Job Log
	Differences between Fiery�WebSpooler and Fiery�Spooler for Windows

	Fiery Spooler for Mac OS computers
	The job list
	Duplicating, copying, moving, and deleting jobs
	Changing print settings for a job
	Using the Job Log


	Chapter 7: Color Calibration
	Introduction
	Understanding calibration
	How calibration works
	Scheduling calibration
	Checking calibration status

	Calibrating with AutoCal from the Control Panel
	Removing calibration

	Working with simulations
	Changing simulation targets


	Appendix A: Print Options
	Where to set print options
	Print options and override hierarchy
	More information about print options


	Appendix B: Font List
	Printer fonts
	Adobe Type 1 fonts
	TrueType fonts


	Appendix C: Troubleshooting
	Error messages
	Maintaining optimal system performance
	Troubleshooting
	General printing problems
	Problems with print quality
	Problems with Fiery Downloader
	Problems with Fiery�WebTools
	Setup error messages
	AutoCal error messages



